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Section 1: Basic User Navigation 
 

1.01 Accessing the project 
 

  Log in to e-Builder: https://gov.e-builder.net. 
 

 

 

 Find the project you wish to access in the list, as shown below, and click on the Project Name to open the 
project; 

 

 
 

 or you can search for your project by entering the project number into the “All projects” dropdown list, 
or by looking for it under the list by clicking dropdown arrow from the “All projects” dropdown list. 

 

 
 

https://gov.e-builder.net/
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 Either option will bring up the “Project Details” page. The  “Project Details” page has a Project Menu 
with links for the modules related to that specific project. 
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Section 2: Project User Access 
  

2.01 For DAS Project Managers: 
 

 When a DAS Project Manager is assigned to a project in e-Builder, the Project Manager may contact 
Project Support Services (Tim O’Brien in Teams or at timothy.o’brien@ct.gov ) to gain access to the 
project in e-Builder. 

 

2.02 For Agency Users: 
 

 Agency PMs may contact Project Support Services (Tim O’Brien in Teams or at timothy.o’brien@ct.gov ) 
to gain access to a project in e-Builder for themselves, or for other agency staff. For each user, please 
provide the following information: 

1. Name 
2. Department 
3. Email address 
4. Project numbers, if only certain projects, or all in a department prefix. 
5. Role: Agency PM, Agency Signatory or review only. 

 

2.03 For Consultants and Contractors 
 

 Requests for user access to a project for consultant staff, contractors or any other outside user should 
come from the DAS Project Manager or from the CA assigned to the project, if the DAS Project Manager 
has delegated the CA with that responsibility. These requests for access may be made to Project Support 
Services (Tim O’Brien in Teams or at timothy.o’brien@ct.gov ). Please provide the following information 
for each user: 

1. Name 

2. Company 

3. Email address 

4. Project number or numbers 

5. Role on project, such as A/E, A/E subconsultant, CA, GC, CMR or other.  

Please specify if the users will only need access to submit invoicing/Payment Applications, otherwise the 
user will be in workflows and get workflow notifications. 

 

  

mailto:timothy.o%E2%80%99brien@ct.gov
mailto:timothy.o%E2%80%99brien@ct.gov
mailto:timothy.o%E2%80%99brien@ct.gov
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Section 3: (Reserved for future use) 
 

3.01 Coming Soon 
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Section 4: Add Funding Sources 
 

4.01 Accessing the Project 
 

 Follow the instructions provided in Section 1 to Access the Project. 
 

 Under the “Project Menu”, click “Cost” and then click “Commitment” to navigate to the Commitment 
record. Click “Edit” after opening the “Commitment Details” page. 

 

 

 

 Click on the pull down menu in the “Funding Rule” column and then select the most appropriate funding 
source. 
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 After selecting the appropriate funding source, click “Save.” 
 

 

 

 Note that the “Funding Rule” has been changed for all of the lines. Click “Save” to complete. 
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Section 5: Edit Budget Details 
 

 The Budget tool in e-Builder is used to track money that has been allocated or otherwise made available 
for commitment and expenditure on a project. The Budget tool is not for the entry of the whole 1105 
project budget unless funding has been allocated for the entire project. The  following instructions 
concern making changes to the Budget in e-Builder so that it reflects the money that has actually been 
allocated to a project. 

 

5.01 Accessing the project 
 

 Follow the instructions provided in Section 1 to Access the Project. 
 

5.02 Creating a new Budget Change entry 
 

 After accessing the project, under the Project Menu: 
 

1. Click the arrow next to “Cost” to open the Cost options. 

2. Then click on “Budget Details”. That will open show the current project allocated Budget. 

3. Then Click on the “Budget Changes” tab. Previously entered budget changes will be listed. 

4. To start a new Budget Change entry, click “Add." 
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 A new screen will open entitled “Add Change Details”. Complete the following: 

1. Select a reason code, such as “Original Budget”. “(Original)” at the end of it means that the 
reason code will make this change show up in the budget as original costs. 

2. Enter a Description. 

3. Select “Save and Add All Line Items”. 
 

 
 

 On the next screen, click, “Continue.” 
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 The “Edit Change Details” screen will open. Then enter the changes: 
 

A This column has the Cost Codes for each line in the Budget. 
B This column has the current Budget amount for each Cost Code. 
C This is the column where the changes being made are entered. Click on the “0.00” or the “pencil” 

button in the line item you want to edit. Enter the change amount for that Cost Code, which can be 
either a positive number, for an addition, or a negative number, for a reduction. 

D The Net Budget Amount for each Cost Code will calculate automatically. The Net Budget Amount is 
equal to the Current Budget Amount (B), plus (or minus for negative numbers) the Change Amount 
(C). 

E The value at the bottom of the Net Budget Amount column should reflect the total amount currently 
allocated to the project. 

F When the entry is complete, click “Save.” 
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5.03 Navigating back to a draft budget change 
 

 To access a previously saved budget change entry: 
1. Follow the instructions in 5.1 & 5.2, steps 1-3 to navigate to the Budget Details/Budget Changes tab. 
2. Click on the item # of the draft change to reopen the draft. 

 

 
 

5.04 Approving a budget change 
 

 A budget change can be approved by clicking “Approve”. Alternatively, the “Edit” button can be clicked 
to re-open the draft for further changes. 

 

 
 

 If “Approve” was selected, the approval confirmation screen will appear. Click or enter the approval 
date. Comments may be entered under “Note,” but are not required. Click “Approve”. 
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5.05 Budget should reflect all approved changes. 
 

 The project budget should now appear updated, based on the sum of the initial budget and all of the 
Budget Change entries. The budget is broken down by cost code in the “Line Item” column and the 
“Current Budget” column should reflect the updated current project budget. The number at the bottom 
of the “Current Budget” column should be the total money allocated to the project, as updated by the 
Budget Changes made. 
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Section 5A: Tracking DAS Fees 
 

5A.01 Accessing the project 
 

 Follow the instructions provided in Section 1 to Access the Project. 
 

5A.02 Creating a Commitment Record for DAS Fees 
 

 The following applies if the project does not already have a Commitment record for DAS fees. 

1. After opening the project record, select “Commitments” under the “Project Menu” and then click on 
“Commitments”. If no commitment appears for DAS fees, click, “Add.” 

 

 
 

 2. That brings up the draft Commitment form. This description will concern three different parts of that 
form (labeled A, B and C, below): 
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A. Add Commitment 
 

 A.1. In the “Commitment Type” field, select, “DAS Fees.” 
 

 
 

 A.2. In the “Company” field, type “Department of Administrative Services”. Note that the Company 
Number will populate automatically as “DAS001”. 

A.3. Enter the Commitment Number, using the following format. Starting with “DAS001” (the 
“company number”), then type one dash. Then, excluding the “BI”, “CF”, etc. and all other 
dashes, enter the project number as shown. 

 

 
 

 A.4. In the “Description” field, type a prose description, such as, “DAS Fees on project 3B-126.” The 
“Unit Cost Options” field should not be changed. 
 

 

B. Add New Commitment Item 
 

 Under the “Add New Commitment Item” section: 
B.1. Click on “Please Select a Line Item”. This is where the Cost Code is selected. 
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 B.2. Click on Cost Code 12.000. 
 

 
 

 B.3. Enter the Amount to be committed to DAS fees, at least initially, and then click “Add”. 
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C. Commitment Items 
 

 Under the “Commitment Items” section, confirm that the information is correct. Any fields with a pencil 
next to them can be opened for editing by clicking on the “pencil”. For example, to edit the Amount, click 
on the pencil next to that number, change the number and click in any blank area of the form to allow it 
to update. 

 

 
 

 C.1. If the information is correct, click “Save.” 
 

 
 

 C.2. Saving the draft commitment leads to a pre-approval summary screen. Before the 
commitment can be used, it must be approved, which Project Managers can do. 
a. To approve the DAS fees commitment, click, “Approve.” 

 

 
 

 b. In the next screen, click on the date hyperlink to populate an approval date or enter an 
“Approval Date.” Enter a note, if applicable.  
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 Then either click “Yes, Approve the Commitment” to approve or “No, Cancel” to return back to the 
screen with the commitment as a draft. 

 

 
 

5A.03 Entering DAS Fees Actual Costs 
 

 1. Under Costs > Commitments, click on the commitment number of the DAS fees commitment. 
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 2. Click on the “Actual Costs” tab and then click on the “Add” button. 
 

 

 

 3. Enter a description of the actuals record in the “Description” field. Under “Invoice Amount,” enter 
the amount of new DAS fees to record, then toggle “Status” to Approved” and then click “Save”. 

 

 
 

 4. In the next screen, click on the date hyperlink to populate an “Approval Date” or enter an “Approval 
Date.” Then click “Yes, Approve the Invoice” to approve or click “No, Cancel” to return to the draft 
screen. 
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 5. If approved, the “Invoice Details” page will open to display the actual cost. Click “Mark Paid” to 
approve (which includes approval under another approve screen). Click the link next to 
“Commitment” to return to the record for the commitment.   

 

 
 

 6. The Commitment Details page shows information about the commitment record, including the 
Current Commitment amount, the Actuals Approved and has a tab to show the Actual Costs 
entries against that commitment. 
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5A.04 Manually Entering a Commitment Change 
 

 To manually change a commitment amount for the DAS fees commitment on a project, proceed as 
follows: 

1. Under Costs > Commitments, click on the commitment number of the DAS fees commitment. 
 

 
 

 2. That leads to the “Commitment Details” screen. On that screen, under the “Commitment 
Changes” tab, click “Add.” 

 

 
 

 3. On the “Add Change Details” page, enter a Description, select the correct change “Reason Code” 
and click “Save and Add All Items.” 
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 4. On the next screen, click “Continue.” 
 

 
 

 5. Under “Change Amount,” enter a positive or negative number for the “Change Amount” and 
click “Save.” 

 

 
 

 6. To approve the commitment change, click “Approve.” Click “Edit” to return to the draft 
commitment change for further editing. 
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 7. If approved, click on the date hyperlink to populate an “Approval Date” or enter an “Approval 
Date.” Enter a note, if applicable, and click “Continue” to approve, or “No, Cancel” to return to 
the commitment change as a draft. 

 

 
 

 8. If “Continue”, the Commitment Change Details page will open, which is the record of that 
commitment change. To return to the commitment, itself, click on the commitment number next 
to label for “Commitment.” 
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Section 5B: PM Creation of Other Commitments 
 Generally, commitments are entered by Project Support Services as part of established procedures. 

There are some circumstances, generally when the commitment was approved prior to the migration 
into e-Builder, when a commitment record may need to be entered manually. PM’s are encouraged to 
contact Project Support Services before doing this in order to avoid the creation of conflicting records. 
Additionally, Project Support Services is available to assist project managers in performing this function, 
should the need arise. The below are instructions for how to create a commitment. 

 

5B.01 Accessing the project 
 

 Follow the instructions provided in Section 1 to Access the Project. 
 

5B.02 Creating a Commitment Record 
 

 1. After opening the project record, click “Cost”, under the “Project Menu”, then click “Commitments”. 
To add a new commitment, click, “Add.” 

 

 
 

 2. That brings up the draft Commitment form. This description will concern three different parts of that 
form (labeled A, B and C, below): 
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A. Add Commitment 
 

 

A.1. Enter the “Commitment Type” field. Ensure that “CMR GMP” is selected for CMR GMP 
commitments, and that “Prime Contractor Contract” is selected for DBB GC commitments. The 
other options are for consultants and other commitments. 

 

 
 

 A.2. In the “Company” field, type “Department of Administrative Services”. Note that the Company 
Number will populate automatically as “DAS001”. 

A.3. Enter the Commitment Number, using the following format. Starting with “DAS001” (the 
“company number”), then type one dash. Then, excluding the “BI”, “CF”, etc. and all other 
dashes, enter the project number as shown. 

A.4. In the “Description” field, type a prose description, such as, “DAS Fees on project 3B-126.” The 
“Unit Cost Options” field should not be changed. 

 

B. Add New Commitment Item 
 

 Under the “Add New Commitment Item” section: 
B.1. Click on “Please Select a Line Item”. This is where the Cost Code is selected. 

 

 

 B.2. Click on the applicable Cost Code. 
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 B.3. Enter the Amount to be committed and then click “Add”. 
 

 
 

C. Commitment Items 
 

 Under the “Commitment Items” section, confirm that the information is correct. Any fields with a pencil 
next to them can be opened for editing by clicking on the “pencil”. For example, to edit the Amount, click 
on the pencil next to that number, change the number and click in any blank area of the form to allow it 
to update. 

 

 
 

 C.1. If the information is correct, click “Save.” 
 

 
 

 C.2. Saving the draft commitment leads to a pre-approval summary screen. Before the 
commitment can be used, it must be approved, which Project Managers can do. 

a. To approve the DAS fees commitment, click, “Approve.” 
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 b. In the next screen, click on the date hyperlink to populate an approval date or enter an 
“Approval Date.” Enter a note, if applicable. Then either click “Yes, Approve the 
Commitment” to approve or “No, Cancel” to return back to the screen with the 
commitment as a draft. 
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Section 5C: Cost To Date Report 
 

5C.01 Coming Soon 
 

 
 



 
0175 e-Builder Guidance Manual 

Page 30 of 199 
 

CT DAS 0175 (Rev. 03.07.2024) 0000 Guidance Manuals 
 

Section 6: Project Manager Monthly Reports 
6.01 Accessing the project 

 
 

 Log in to e-Builder: https://gov.e-builder.net. 
 

 On your homepage, find your project by clicking on the top tab for “Projects”:  
 

 

 

 Search for your project by entering the project number or by looking for it under the list that appears 
below on this screen. 

 

 Click on your project to bring up the “Project Details” page.  
 

6.02 Starting the Project Manager Monthly Status Report process (One time per project). 
 

 Note: The Project Manager Monthly Status Report process only requires one process instance per 
project. Only complete Step 1 for the first monthly report submission. For each subsequent report 
submission, begin at Step 6.03. 

 

 Within the project’s record, go to the Processes module in the Project Menu.  Then click on the Start 
Process button. 

 

 
 

 Note: If you do not see all of your projects, contact Tim O’Brien to gain access to them in e-Builder. 
 
 

https://gov.e-builder.net/
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 Click on the “Project Manager Monthly Status Report (PMrep)” process. 
 

 
 

 Enter the due date of the first project report on this project in e-Builder and then click Submit. 
 

 
 

6.03 Starting a second or subsequent project status report. 
 

 Within the project’s record, go to the Processes module in the Project Menu.  Then click on the Start 
Process button. 
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 Enter the due date of the current report and then click “Take Action”. Note that the only workflow action 
available will be to Start. 

 

 
 

6.04 Completing the monthly report form 
 

 Access the process instance for what should be the one instance of the “Project Manager Monthly Status 
Report (PMrep)” process. 
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 Complete the monthly update form. 
 

 Note: If a monthly report was completed in the previous month for the subject project, the information 
from that month’s report will still be included in the current report form, except that, if there were any 
manual updates to the project details during that month, i.e. project status or budget information 
updates, those updates should have refreshed and be included in the updated information. 
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 If the PM is unable to complete the report in one sitting, the PM can click the “Save” button to save a 
draft of the report. The PM can regain access to complete the draft report by returning to, and re-
opening,  the process instance. 

Upon completion of the monthly report, the PM should scroll down to the bottom of the page and either 
select “Progress Report” (project is in process) or “Last Report” (final monthly report at project closeout) 
from the dropdown list next to the “Take Action” button and click the “Take Action” button. 

 

 
 

 The ADPM and PM on the project should then receive an email notification with a PDF of the report 
attached. 
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 This file should also appear in the project’s Documents module in e-Builder, in the 01 Project Planning > 
Progress Reports folder. Note that the number at the end of the file name indicates the due date of this 
report. 

 

 
 

 In the project’s Details page, certain, but not all, fields will be updated from what was entered into the 
monthly report, such as DAS Project Status, Total Project Cost and Construction Budget. 
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PART II:  

PROCESSES 
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Section 7: Process Filter 
 
 

 “Filter Processes” can be found under the “Processes” tab in eBuilder. “Filter Processes” allows the user 
to locate and list certain process instances, including whether process instances are in the user’s court, 
the type of process, and the status and step of the process instance. 

 

 1. Change the Process filter settings to find the process instances you are looking for. For example, 
users may filter for process instances of a specific Type of Process. Selecting All Processes will 
show all instances, regardless of whose ball-in-court the instances are in. Draft, Open or Finished 
status can be selected, as well. 

2. The filtered list appears here. Click on the instance you wish to open. A pop-up will open. That is 
the process instance. 
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Section 8: 1105 Project Intake Request 
 

8.01 Accessing the Process 
 

 Log in to e-Builder: https://gov.e-builder.net/auth/www/index.aspx?ReturnUrl=%2f. On your homepage, 
Go to the “Processes” tab and select the “*Project Creation Project” from the “All Projects” dropdown 
list. 

 

8.02 Capital Project Initiation Submission (Process Initiator) 
 

 Click the “Start Process” button. 
 

 

 

 Click on the link entitled “1105 Project Intake Request (1105)”. 
 

 

 

 

 Provide the “Project Name” and select from the “Agency Request for Project Administration” dropdown 
list whether the project will be administered by “DAS/CS” or “Agency Administered”.  Upon completion, 
click the “Submit” button to start the process. 

 

 
 

 Depending upon how the project administration question was answered, the Process Initiator will be 
directed to fill out the required portion of Form 1105 – Capital Project Initiation Request. 

 

https://gov.e-builder.net/auth/www/index.aspx?ReturnUrl=%2f
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 To access the newly created Form 1105, click on the “Processes” tab again to reset the landing page, 
select “1105 Project Intake Request” from the view dropdown list, and click on the link in the “Process” 
column for the subject project. 

 

 
 

 Review the “General Instructions” and complete Form 1105 in its entirety. 
 

 
 

 Helpful Hints for completing Form 1105 
 

 The “Agency PM” is to be selected from a dropdown list of Agency PM’s. If the Agency PM is not listed, 
please contact Craig Russell by email at craig.russell@ct.gov and request that the name be added. 

 

 State/Federal/Other Funding - When completing these sections, be sure to hover over the “?” next to the 
respective field for an explanation of what is to be provided in that field. For each line item, you will 
need to provide a “Description”, amount “Awarded/Authorized”, amount “Received/Allocated”, and the 
“Funding Source” if not State Bond Funds. After filling in the required fields, click the “Add” button. This 
step will need to be repeated for each line item. 
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 Project Budget Detail – The 1105 Project Budget Detail spreadsheet will need to be downloaded from the 
DAS/CS Portal and filled out separately from the eBuilder 1105 Project Intake Process. Upon completion, 
the project budget should be saved, dragged and dropped into the “1105 Project Budget” field. 

 

 
 

 Upon completion of the draft Form 1105, scroll down to the bottom of the page, read the instructions 
for the section entitled “Interagency Review”, and then select either “Interagency” from the dropdown 
list next to the “Take Action” button if there are any individuals within or outside of your Agency that 
need to review or provide data input into the subject 1105 prior to submitting the 1105 to PSS for ADPM 
assignment and review; or “Submit” if no interagency review is required. 

 

 After selecting your option, you will receive a prompt to provide a comment, for the next individual in 
the process slated to review the 1105 submission. If “Interagency” was selected, provide the reviewer 
with the required direction for data input and/or to help them complete their review of the subject 1105 
submission in the comment section. If “Submit” was selected you have the option to provide a comment, 
but it is not required. 

 
 

 
 

 
 

 If you selected “Interagency”, you will also be required to either select an individual with an active 
eBuilder account from the list of “Available Users” to send the 1105 submission to for review, or input 
the email address of an outside user that does not have an account in eBuilder to allow them the ability 
to review and comment on the 1105 submission. 

∗ Please note that only one (1) user at a time can be selected to review, comment, and if 
applicable, edit the revised submission. Repeat this process for each individual reviewer until all 
revisions are complete.  

∗ Please also note that only those individuals with eBuilder accounts will have the ability to edit 
the draft 1105 submission in eBuilder. Individuals without eBuilder accounts will only have the 
ability to view the 1105 submission and provide comments, under the “Comments” tab, 
regarding the submission. Any proposed revisions recommended by the outside user would have 
to be input by the individual that initiated the 1105 process. 

 

 To add an actor to the next step in the process, find the name of the actor from the list of “Available 
Users”, click on their name to select the person, then click on the “>” to move that person into the 
“Selected Users” column. 

Interagency 
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To add an outside user, enter the outside users email address to the “To” field under “Request External 
Comment”. When entering the email address, the word “Add” will appear to the left of the email you are 
typing in. Click “Add” after you have entered the complete address.  

Complete the remainder of the questions under the “Request External Comment” section. Upon 
completion, click the applicable button to proceed to the next step in the process, which will either be 
“Submit” (no interagency review) or “Interagency” (interagency review).  

 

 
 

 If there is an individual from your agency that should be granted access to Interagency Review and is not 
included in the list of actors, please contact Tim O’Brien by email at Timothy.O’Brien@ct.gov and request 
that the name be added. 

 

8.03 Other Reviewers (Interagency/Outside Reviewer) 
 

 The Interagency Reviewer will receive an email from eBuilder as notification that the Capital Project 
Initiation Request is ready for them to review. 

 

 To access the Capital Project Initiation Request for revision, either click on the email link or log into 
eBuilder (https://gov.e-builder.net/auth/www/index.aspx?ReturnUrl=%2f ), if you have an active 
eBuilder account, select the “My Home” tab and click on the “Instance” column link for the subject 
project under “My Processes”. 
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 After opening the project instance, click on the “Comments” tab to review comments provided by 
previous actors and to get direction related to the 1105 review; then return to the “Details” tab to 
review, and if applicable edit the submission. If the reviewer does not have editing capabilities, provide 
direction for proposed revisions under the “Comments” tab after reviewing the 1105 submission. 

 

 

 Upon completion of the review, scroll down to the bottom of the page and click “Take Action” to return 
the 1105 to the process initiator. 

 

8.04 ADPM Assignment (PSS) 
 

 PSS will receive an email from eBuilder as notification that the  Capital Project Initiation Request has 
been submitted for ADPM Assignment.  

After accessing the 1105 submission, PSS will scroll down to the bottom of the page and complete the 
Section entitled “Project Assignment”. Upon completion, click “Submit”. After clicking submit, a prompt 
will open for PSS to select the appropriate ADPM for review. Once selected, click “Submit”. 

 
 

 
 

 

  

 



 
0175 e-Builder Guidance Manual 

Page 43 of 199 
 

CT DAS 0175 (Rev. 03.07.2024) 0000 Guidance Manuals 
 

8.05 Capital Project Initiation Request Review (ADPM) 
 

 The ADPM assigned to the Agency will receive an email from eBuilder as notification that the  Capital 
Project Initiation Request has been submitted for them to take action. 

 

 To access Form 1105 for review and approval, the ADPM can either click on the link provided in the email 
or log into eBuilder, click on the “Processes” tab, select the “1105 Project Intake Request”  view from 
the dropdown list, and click on the link in the “Process” column for the subject project. 

 

 

 
 

 The ADPM can review the 1105 submission in its entirety under the “Details” tab.  

To see any comments provided by previous actors in the process regarding the Capital Project Initiation 
Request submission, the ADPM can click on the “Comments” tab to review those comments.  

 

 To see the “1105 Project Budget Details”, the ADPM can click on the “Documents” tab and then double 
click the “1105 Project Budget.xlsx” to open the budget for review. 
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 Upon completion of the Capital Project Initiation Request review, scroll down to the bottom of the page 
and complete the section entitled “CT DAS Management Review and Approval”. 

 

 
 

 Then select one of the following from the dropdown list at the bottom of the page next to the “Take 
Action” button: 

 

 • "Revise" if the project requires the User Agency to revise the 1105 for resubmission. 
• "Approve" if the content of the 1105 is approved and ready for the Agency Authorized Signatory 

and the Deputy Commissioner for review and approval. 

∗ Note: If the ADPM answered the “Consultant “Selection Type(s)” question as “Formal A/E 
Selection”, then the 1105 will automatically be forwarded to the Chief Architect for review 
prior to being forwarded to the Agency Authorized Signatory and the Deputy Commissioner 
for review and approval. 

Once you have made your selection from the dropdown list, click the "Take Action" button. After 
selecting the "Take Action" button, a comment prompt will appear, where you can provide a reason for 
your selection, if applicable. After providing a comment click the appropriate button (Revise or Approve) 
to move the 1105 to the next step in the process. 
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8.06 Capital Project Initiation Request Revision (Process Initiator) 
 

 If the Capital Project Initiation Request requires revision, the Process Initiator will receive an email 
notification from eBuilder that the Capital Project Initiation Request has been returned for revision. 

 

 To access Form 1105 for review and revision, the Process Initiator can either click on the link provided in 
the email or log into eBuilder, click on the “Processes” tab, select the “1105 Project Intake Request”  
view from the dropdown list, and click on the link in the “Process” column for the subject project. 

 

 

 
 

 Click on the “Comments” tab to review any comments provided regarding the Capital Project Initiation 
Request submission. 

 

 If the Capital Project Initiation Request itself requires revision, click on the “Details” tab and make the 
required revisions within the Capital Project Initiation Request for resubmission. 

 

 
 

 If the 1105 Project Budget Detail requires revision, click the “Documents” tab, and then click the 
“Download” link beneath the project budget to download the project budget to an accessible file to 
upload back into eBuilder. 
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 After completing edits to the project budget detail, save your changes, and then drag and drop the 
edited document back into the “Documents” tab in eBuilder. The latest version of the project budget 
edits will have the highest version number. 

 

 
 

 After all revisions have been made, scroll down to the bottom of the page, select “Submit” from the 
dropdown list next to the “Take Action” button and click “Take Action” to send the revised 1105 back to 
DAS/CS for further review and processing. 

 

 After clicking the “Take Action” button, the Process Initiator will receive a prompt to provide a comment 
to the ADPM regarding the revisions made. After providing a comment, the Process Initiator should 
select Craig Russell from the list under “Add actors to the next step” and click the “>” to add him to the 
“Available Users” column and click “Submit”. 

 

 

 
 

 Repeat Steps 8.4 – 8.6 until such time that the ADPM approves the Capital Project Initiation Request 
submission. 

 

8.07 Capital Project Initiation Request Review (Chief Architect) 
 

 If the ADPM answered the “Consultant Selection Type(s)” question as “Formal A/E Selection”, then the 
Chief Architect will receive an email from eBuilder as notification that the  Capital Project Initiation 
Request has been “Approved” by the ADPM and is ready for the Chief Architect to review. 
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 To access Form 1105 for review and revision, the Process Initiator can either click on the link provided in 
the email or log into eBuilder, click on the “Processes” tab, select the “1105 Project Intake Request”  
view from the dropdown list, and click on the link in the “Process” column for the subject project. 

 

 
 

 
 

 To review the 1105 submission in its entirety, click on the “Details” tab.  

To see any comments provided by previous actors in the process regarding the Capital Project Initiation 
Request submission, click on the “Comments” tab to review those comments.  

To see the “1105 Project Budget Details”, click on the “Documents” tab and then double click the “1105 
Project Budget.xlsx” to open the budget for review. 

 

 

 

 

 Upon completion of the Capital Project Initiation Request review, scroll down to the bottom of the page 
and either select “Return” from the dropdown list at the bottom of the page next to the “Take Action” to 
return the submission to the ADPM, or select “Submit” to forward the submission for the selection of the 
Agency Authorized Signatory and then click “Take Action”.  After clicking the "Take Action" button, you 

https://gov.e-builder.net/auth/www/index.aspx?ReturnUrl=%2f
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will be prompted to provide a comment, where you can provide detail regarding your review of the 1105 
submission. Once you have added a comment, click the applicable button - “Return” or “Submit”. 

 

 

8.08 Authorized Signatory Selection (Process Initiator) 
 

 The Process Initiator will receive an email from eBuilder as notification that the Capital Project Initiation 
Request has been submitted for them to take action. 

 

 To access the Capital Project Initiation Request for revision, either click on the email link or log into 
eBuilder (https://gov.e-builder.net/auth/www/index.aspx?ReturnUrl=%2f), select the “My Home” tab 
and click on the “Instance” column link for the subject project under “My Processes”. 

 

 After opening the link to the 1105 submission, scroll down to the bottom of the page and click the “Take 
Action” button. 

 

 After clicking the “Take Action” button, the Process Initiator will receive a prompt to provide a comment 
to the Agency Authorized Signatory for sign off. After providing a comment, the Process Initiator should 
select your Agency Authorized Authority from the list of Authorized Signatories under “Add actors to the 
next step” and click the “>” to add the signatory to the “Selected Users” column from the “Available 
Users” column and click “Submit” to send the revised 1105 to the Authorized Signatory for signature. 

 

 
 
 

 

 If your Agency Authorized Signatory is not listed, please contact please contact Tim O’Brien by email at 
Timothy.O’Brien@ct.gov and request that the name be added. 

 
 

Submit 
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8.09 Capital Project Initiation Sign Off (Agency Authorized Signatory) 
 

 The Agency Authorized Signatory (AAS) will receive an email from eBuilder as notification that the  
Capital Project Initiation Request has been submitted for them to take action. 

 

 To access Form 1105 for review and approval, the AAS can either click on the link provided in the email 
or log into eBuilder, click on the “Processes” tab, select the “1105 Project Intake Request”  view from 
the dropdown list, and click on the link in the “Process” column for the subject project. 

 

 
 

 
 

 The AAS can review the 1105 submission in its entirety under the “Details” tab.  

To see any comments provided by previous actors in the process regarding the Capital Project Initiation 
Request submission, the AAS can click on the “Comments” tab to review those comments.  

To see the “1105 Project Budget Details”, the AAS can click on the “Documents” tab and then double 
click the “1105 Project Budget.xlsx” to open the budget for review. 
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 Upon completion of the Capital Project Initiation Request review, the AAS should return to the “Details” 
tab and scroll down to the bottom of the page to complete the section entitled “Capital Project – Agency 
Authorization”. The AAS will select either “Approve” or “Reject” the Capital Project Authorization, and 
provide his/her name and title as the Agency Authorized Authority. Upon completion, the AAS will either 
select “Approve” or “Reject” from the dropdown list next to the “Take Action” button and click “Take 
Action”. 

 

 
 

 • If “Reject” was selected, the AAS will be given a prompt to provide a comment to the Process 
Initiator regarding the reason for rejection and/or instructions for revision and resubmission. After 
providing a comment, click “Reject” to return the 1105 submission to the Process Initiator for 
revision and resubmission. 

 

 
 
 

 • If “Approve” was selected, the 1105 will be submitted to DAS/CS for submission to the DAS/CS 
Deputy Commissioner for review and approval. 

 

8.10 Capital Project Initiation Request Review (PSS) 
 

 If the Agency Signatory chose “Approve”, PSS will receive an email from eBuilder as notification that the  
Capital Project Initiation Request has been submitted for them to take action. 

 

 No additional review is necessary at this point. Scroll down to the bottom of the page and select 
“Submit” from the dropdown list next to the “Take Action” button and click “Take Action” to send the 
1105 submission to the Deputy Commissioner for review and signature. 

 

 After clicking the “Take Action” button, you will receive a prompt to provide a comment to the Deputy 
Commissioner. Click on the instructions tab at the top of the page for draft language to include as part of 
the comment to the Deputy Commissioner. Click “Submit” to forward the 1105 to the Deputy 
Commissioner for signature. 
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8.11 Capital Project Initiation Request Review (DC) 
 

 The Deputy Commissioner (DC) will receive an email from eBuilder as notification that the  Capital 
Project Initiation Request has been submitted for them to take action. 

 

 To access Form 1105 for review and approval, the DC can either click on the link provided in the email or 
log into eBuilder, click on the “Processes” tab, select the “1105 Project Intake Request”  view from the 
dropdown list, and click on the link in the “Process” column for the subject project. 

 

 

 

 

 
 

 The DC can review the 1105 submission in its entirety under the “Details” tab.  
To see any comments provided by previous actors in the process regarding the Capital Project Initiation 
Request submission, the DC can click on the “Comments” tab to review those comments.  
To see the “1105 Project Budget Details”, the DC can click on the “Documents” tab and then double click 
the “1105 Project Budget.xlsx” to open the budget for review. 
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 Upon completion of the Capital Project Initiation Request review, scroll down to the bottom of the page 
and read the instructions for and complete the section entitled “Capital Construction Project – DAS 
Approval”, then select either “Approve” or “Reject” from the dropdown list at the bottom of the page 
next to the “Take Action” button and click “Take Action”. 

 

 
 

 ∗ If “Reject” was selected, you will receive a prompt to provide a comment to the ADPM to explain the 
reason for rejection and click “Reject” to return the submission to the ADPM. The ADPM will then 
contact the Client Agency to discuss proposed revisions. 

 

 ∗ If “Reject” was selected, you will receive a prompt to provide a comment to the ADPM to 
explain the reason for rejection and click “Reject” to return the submission to the ADPM. 
The ADPM will then contact the Client Agency to discuss proposed revisions.  

 

 
 

8.12 Capital Project Initiation Request Project Number Assignment (PSS) 
 

 PSS will receive an email from eBuilder as notification that the  Capital Project Initiation Request has 
been submitted for them to take action. 

 

 To access Form 1105 for review and approval, PSS can either click on the link provided in the email or log 
into eBuilder, click on the “Processes” tab, select the “1105 Project Intake Request”  view from the 
dropdown list, and click on the link in the “Process” column for the subject project. 

 

 PSS shall complete and submit Form 1115 – Capital Project Number Request to Financial Administrative 
Services (FAS) to assign a number to the project through normal means, outside of eBuilder. 

 

 Upon receipt of the project number assignment, PSS will log back into eBuilder, select the “My Home” 
tab and click on the “Instance” column link for *Project Creation Project under “My Processes”. 
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 PSS will complete the sections entitled “Project Number” and “Project Budget Detail” and upload a copy 
of the executed Form 1115 to the respective field in eBuilder. PSS will then scroll down to the bottom of 
the page, select “Submit” from the dropdown list next to the “Take Action” button and click “Take 
Action” to forward to Environmental Services for CEPA review. 

 

8.11 Capital Project Initiation Request CEPA Review (Environmental Services) 
 

 The Environmental Analyst (EA) will receive an email from eBuilder as notification that the  Capital 
Project Initiation Request has been submitted for them to take action. 

 

 To access Form 1105 for review and approval, the EA can either click on the link provided in the email or 
log into eBuilder, click on the “Processes” tab, select the “1105 Project Intake Request”  view from the 
dropdown list, and click on the link in the “Process” column for the subject project. 

 

 
 

 
 

 The EA can review the 1105 submission in its entirety under the “Details” tab.  
To see any comments provided by previous actors in the process regarding the Capital Project Initiation 
Request submission, the EA can click on the “Comments” tab to review those comments.  
To see the “1105 Project Budget Details”, the EA can click on the “Documents” tab and then double click 
the “1105 Project Budget.xlsx” to open the budget for review. 
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 Upon completion of the Capital Project Initiation Request review, scroll down to the bottom of the page 
and complete the section entitled “DAS Environment Review” and upload a copy of the Initial 
Environmental Review to the respective field in eBuilder. Upon completion, select “Submit” from the 
dropdown list next to the “Take Action” button and click “Take Action”. 

 

 
 

 The 1105 Project Intake Process is now complete. A copy of the executed Form 1105 will be distributed, 
via email through eBuilder,  to all process participants and to the subject project file folder. 
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Section 9: 1105R Project Revision Request 
 

9.01 Accessing the Process 
 

 Log in to e-Builder: https://gov.e-builder.net/auth/www/index.aspx?ReturnUrl=%2f 
 

 On your homepage, Go to the “Processes” tab and select the “*Project Creation Project” from the “All 
Projects” dropdown list. 

 

 

 

9.02 Project Revision Request Submission (Process Initiator) 
 

 Click the “Start Process” button. 
 

 
 

 Click on the “1105R Project Revision Request (1105R)” link to start the process. 
 

 
 

 Answer the question under the header “Revised Capital Project Initiation Request”. 
 

 
 

 Only answer "Yes" if the original 1105 submission for the subject project was completed by the Client 
Agency through eBuilder or if the first iteration of the revised 1105 submission was entered into 
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eBuilder by the Client Agency using this process. This will notify DAS of the request, at which time DAS 
will import the original submission back into eBuilder and send it back to the Process Initiator for 
revision.  

If the 1105 information for the subject project was not entered into eBuilder by the Client Agency, 
answer "No".   

∗ Please note that if future revisions are required to this 1105 submission, the Client Agency can 
answer “Yes” to having  the first iteration of the revised 1105 submission as being entered into 
eBuilder and DAS can import that submission back into eBuilder for the Client Agency to edit. 

 

 Answer the question under the header “Agency Request for Project Administration” and click the “Take 
Action button.  

 

 
 

 If the Agency answered “Yes” to the “Was an original or revised 1105 submitted by the Client Agency for 
this project,” the submission will be forwarded to Project Support Services to initiate the “1105R Project 
Import Process”, at which time the original or revised 1105 that was entered into eBuilder will be 
imported back into eBuilder and forwarded to the Agency for revision and submission. 

If the Agency answered “No” to the question, the request will be forwarded to the Process Initiator to 
complete the revised Capital Project Initiation Request. 

 

9.03 Complete Revised Capital Project Initiation Request (Process Initiator) 
 

 The Process Initiator will receive an email from eBuilder as notification that the Capital Project Initiation 
Request is ready for them to prepare the revised 1105 for submission in eBuilder. 

 

 To access the Capital Project Initiation Request for revision, either click on the email link or log into 
eBuilder (https://gov.e-builder.net/auth/www/index.aspx?ReturnUrl=%2f), select the “My Home” tab 
and click on the “Instance” column link for the subject project under “My Processes”.   
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 If the Client Agency answered “No” to the question “Was an original or revised 1105 submitted by the 
Client Agency through eBuilder”, then either no data will be imported (the project does not exist in 
eBuilder), or if DAS/CS entered the data for the subject project into eBuilder prior to the release of the 
program to the Client Agency, then some data will be transferred into the revised 1105 submission, but 
that data will be primarily limited to Administrative information. The Client Agency will be responsible 
for completing the  balance of the revised 1105 submission. To complete the revised 1105 submission, 
the Client Agency will follow the directions provided under “Section 8: 1105 Project Intake Request, Line 
8.2 – Capital Project Initiation Submission” of this document, and scroll down to “Helpful Hints for 
completing 1105” to begin the process for completing the revised 1105. 

 

 If the Client Agency answered “Yes” to the question “Was an original or revised 1105 submitted by the 
Client Agency through eBuilder”, then the data import should be comprehensive. The Client Agency 
should review the data imported and revise the 1105 accordingly. At minimum, the Client Agency will be 
required to provide data input for the following fields and sections: 

 

 a. Within the “Administrative Information” section, answer the question “Agency Request for Project 
Administration” again and revise the “Project Description and Special Requirements” field, if 
applicable. 

 

 
 

 b. Within the “Budget Details” section, upload a revised “1105 Project Budget”; and 
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 c. Complete the Financial Information section. Be sure to hover over the “?” next to the respective field 
for an explanation of what information is to be provided. For each line item, provide a “Description”, 
amount “Awarded/Authorized”, “Received/Allocated”, “Encumbrance”, and the “Funding Source”, if 
not State Bond Funds. Upon completion, click “Add”. Repeat this step for each line item. 

 

 
 

 Upon completion of the draft Form 1105R, scroll down to the bottom of the page, read the instructions 
for the section entitled “Interagency Review”, and then select either “Interagency” from the dropdown 
list next to the “Take Action” button if there are any individuals within or outside of your Agency that 
need to review or provide data input into the subject 1105 prior to submitting the 1105 to PSS for ADPM 
assignment and review; or “Submit” if no interagency review is required. 

 

 After selecting your option, you will receive a prompt to provide a comment, for the next individual in 
the process slated to review the 1105 submission. If “Interagency” was selected, provide the reviewer 
with the required direction for data input and/or to help them complete their review of the subject 1105 
submission in the comment section. If “Submit” was selected you have the option to provide a comment, 
but it is not required. 

 
 

 
 

 
 

 If you selected “Interagency”, you will also be required to either select an individual with an active 
eBuilder account from the list of “Available Users” to send the 1105 submission to for review, or input 
the email address of an outside user that does not have an account in eBuilder to allow them the ability 
to review and comment on the 1105 submission. 

∗ Please note that only one (1) user at a time can be selected to review, comment, and if 
applicable, edit the revised submission. Repeat this process for each individual reviewer until all 
revisions are complete.  

∗ Please also note that only those individuals with eBuilder accounts will have the ability to edit 
the draft 1105 submission in eBuilder. Individuals without eBuilder accounts will only have the 
ability to view the 1105 submission and provide comments, under the “Comments” tab, 
regarding the submission. Any proposed revisions recommended by the outside user would have 
to be input by the individual that initiated the 1105 process. 

 

Interagency 
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 To add an actor to the next step in the process, find the name of the actor from the list of “Available 
Users”, click on their name to select the person, then click on the “>” to move that person into the 
“Selected Users” column. 

To add an outside user, enter the outside users email address to the “To” field under “Request External 
Comment”. When entering the email address, the word “Add” will appear to the left of the email you are 
typing in. Click “Add” after you have entered the complete address.  

Complete the remainder of the questions under the “Request External Comment” section. Upon 
completion, click the applicable button to proceed to the next step in the process, which will either be 
“Submit” (no interagency review) or “Interagency” (interagency review).  

 

 
 

 If there is an individual from your agency that should be granted access to Interagency Review and is not 
included in the list of actors, please contact Tim O’Brien by email at Timothy.O’Brien@ct.gov and request 
that the name be added. 

 

9.04 Other Reviewers (Interagency/Outside Reviewer) 
 

 
 

 

The balance of the “1105R Project Revision Request” process will be completed in the same format as 
the “1105 Project Intake Request” process, including Steps 8.03 – 8.11, and 8.13. 

∗ Please note that process instances in the 1105 process begin with “1105” and process instances 
for the 1105R process begin with “1105R”. 
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Section 10: 1135 Task Letter 
 

10.01 Accessing the Process 
 

 Log in to e-Builder: https://gov.e-builder.net/auth/www/index.aspx?ReturnUrl=%2f 
 

 On your homepage, Go to the “Processes” tab and select the project for which you want to submit Form 
1135 from the dropdown list. 

 

 
 
 

10.02 On-Call Request (PM if DAS Administered or Supplemental Task; PSS if AA Administered) 
 

 Select 1135 – Task Letter from the  “All Processes” dropdown list and click “Start Process”. 
 

 
 

 In the subject field at the top of the page input “Project Number - On-Call (On-Call Contract Type – ARC, 
CA, etc.) Request”, i.e. BI-2B-472 – On-Call Architect Request. 
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 Below the subject are directions with a link to create a project task letter file folder within: 

∗ The On-Call Checklist Review file folder (if the cumulative total of all task letters for a consultant 
is less than $100,000) for DAS Administered Projects (PM); or 

∗ The AA Projects – DAS.CS.PM file folder (if the cumulative total of all task letters for a consultant 
is less than $100,000) for AA Projects (PSS); or 

∗ The SPRB Contract Approval file folder  (if the cumulative total of all task letters for a consultant 
is greater than or equal to $100,000) for DAS Administered Projects (PM) or Agency 
Administered Projects (PSS). 

 

 
 

 Right click on the applicable hyperlink and select “Open Link in New Tab” to open the file folder structure 
in SharePoint. 

 
 

https://ctgovexec-my.sharepoint.com/personal/craig_russell_ct_gov/_layouts/15/onedrive.aspx?id=%2Fpersonal%2Fcraig%5Frussell%5Fct%5Fgov%2FDocuments%2FOn%2DCall%20Checklist%20Review%20New&FolderCTID=0x0120008B1B7EDC70456542A9148C0CF78173FD
https://ctgovexec.sharepoint.com/:f:/r/sites/DASCS.PM/Shared%20Documents/AA%20Projects?csf=1&web=1&e=UswIrE
https://ctgovexec-my.sharepoint.com/:f:/r/personal/craig_russell_ct_gov/Documents/SPRB%20Contract%20Approval?csf=1&web=1&e=OWrlbn
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 If the “On-Call Checklist Review” file folder was selected, click on the file folder with your ADPM’s initials 
to open the file folder. 

 

 
 

 After opening either the appropriate file folder within “On-Call Checklist Review”, or the “SPRB Contract 
Review“, or the “AA Projects – DAS.CS.PM” file folder under a separate tab, click the “New” button at the 
top of the page to create a new file folder for the subject project. 

 

 
 

 Naming protocol for the project task letter file folder is the Project Number – Project Name, i.e. BI-2B-
472 – DPH Flex Lab. 

 

 Upon completion, hover over the newly created file folder and click on the ellipsis “…”. 
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 Select “Copy Link” and then paste the link in the “On-Call Selection Request” field in eBuilder and click 
“Save Draft”. 

 

 

 
 

 Complete Form 1135 and upload the 1135 and the executed 1105 with the project budget to the project 
task letter file folder you created. 

∗ If the Form 1135 submission is for a supplemental task on an expired On-Call Contract, also complete 
and upload a “Supplemental Task Justification Memo” to the project task letter file folder. 

 

 After uploading the documents to the project task letter file folder, return to the “Processes” tab in 
eBuilder and select the subject project from the “All Projects” dropdown list. 

 

 
 
 

 Click on the link to the subject project to open the project process. 
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 After opening the project process, scroll down to the bottom of the page and select “Submit” from the 
dropdown list next to the “Take Action” button and click on the “Take Action” button. 

 

 After clicking the “Take Action” button, you will receive a prompt to select an ADPM to review the 1135 
submission. Select the appropriate ADPM from “Available Users” and move them to “Selected Users” by 
clicking the “>”. Then click “Submit” to submit the request to your ADPM. 

 

 
 

10.03 ADPM 1135 Review (ADPM) 
 

 The ADPM will receive an email from eBuilder as notification of the request for On-Call Assignment. To 
access the project process, either click on the link provided in the email or log into eBuilder, select the 
“My Home” tab and click on the subject project process link from the “My Processes” section.   

 

 

 

 
 

 After opening the project process, review the “General Instructions” and then click on the file folder 
project link provided in the “On-Call Selection Request” field to access the On-Call Selection Request 
(Form 1135) for review. 

 

 

 

 After completing the review, scroll down to the bottom of the page and either select "Submit" from the 
dropdown list next to the "Take Action" button to forward the On-Call Selection Request to PSS for 
assignment, or "Revise" to return the On-Call Selection Request to the PM for revision, and click the 
"Take Action" button. You will be prompted to provide a comment. 

If "Submit" was selected, utilize the comment section to provide applicable detail regarding any 
intricacies to the project that PSS should be made aware of, or if there is a specific consultant that is 
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being requested for this project, please provide that information along with the reason why that specific 
consultant should be selected. 

If "Revise" was selected, provide the PM with direction on the revisions required to process the 
submission for approval in the comment section. 

 

10.04 PM Revision – 1105/1135 (PM) 
 

 The PM will receive an email from eBuilder as notification that a revision is required to process the 
request for On-Call Assignment. To access the project process, either click on the link provided in the 
email or log into eBuilder, select the “My Home” tab and click on the link in the “Instance” column for 
the subject project  under the “My Processes” section. The process “Step” will be entitled “PM Revision – 
1105/1135”.   
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 After opening the project process, review the “General Instructions” under the “Details” tab, and any 
comments provided under the “Comments” tab. Click on the file folder project link provided in the “On-
Call Selection Request” field to access the On-Call Selection Request (Form 1135) Forms for revision and 
revise accordingly. Upon completion, click “Take Action”. 

 

 
 

10.05 On-Call Assignment (PSS) 
 

 PSS will receive an email from eBuilder as notification of the request for On-Call Assignment.  

To access the project process, either click on the link provided in the email or log into eBuilder, select the 
“My Home” tab and click on the subject project process link from the “My Processes” section.   

 

 To access the On-Call Selection Request (Form 1135), click on the file folder project link provided in the 
“On-Call Selection Request” field. 

 

 PSS shall then review Form 1135, assign a Consultant to the project, upload the executed Form 1135 to 
the project file folder, complete filling out the “On-Call Information” section in eBuilder and click 
“Submit” to spawn the “Task Letter Cost Integration” process. After completing the Task Letter Cost 
Integration process, PSS will click the “Take Action” button to forward the assigned request to the PM to 
begin preparing the task letter package. 

 

10.06 Prepare Task Letter Package (PM) 
 

 The PM will receive an email from eBuilder as notification that a revision is required to process the 
request for On-Call Assignment.  

To access the project process, either click on the link provided in the email or log into eBuilder, select the 
“My Home” tab and click on the link in the “Instance” column for the subject project  under the “My 
Processes” section. The process “Step” will be entitled “PM Revision – 1105/1135”.   
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 After opening the project process, review the instructions provided under the “On-Call Consultant 
Request” section to begin preparing the task letter package for submission. 

 

 To access the On-Call Assignment, click on the file folder project link provided in the “On-Call Selection 
Request” field. 

 

 
 

 After opening the project process file folder, open the executed Form 1135 from the project file folder to 
see the consultant assigned to the project and schedule the scope review meeting. No action will be 
taken in eBuilder until the draft task letter package is complete. 

 

 Upon completion of the draft task letter package, log back into eBuilder, select the “My Home” tab, and 
click on the subject project from the list under “My Processes”. 

 

 Right click on the file folder project link provided in the “On-Call Selection Request” field and select 
“Open Link in New Tab”. 

 

 
 

 Upload the applicable documents, listed in the instructions, to the file folder to complete the task letter 
package for submission. 

 

 Return to the open eBuilder tab and enter the “Date of Scope Review”, select “Submit” from the 
dropdown list and click the “Take Action” button. 

 

 

10.07 Support Services Review (PSS) 
 

 PSS will receive an email from eBuilder as notification of the request for On-Call Assignment.  
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To access the project process, either click on the link provided in the email or log into eBuilder, select the 
“My Home” tab and click on the subject project process link from the “My Processes” section.   

 

 Right click on the file folder project link provided in the “On-Call Selection Request” field and select 
“Open Link in New Tab”. 

 

 Review the task letter package submission. 
 

 If the value of the task letter, or if a supplemental task the cumulative value of all task letters, is less than 
$100,000, PSS shall conduct the initial review of said task letter, and if applicable, revise and return the 
task letter to the PM for review and revision. 

 

 If the value of the task letter, or if a supplemental task the cumulative value of all task letters, is greater 
than $100,000, PSS shall forward the task letter package to the ADPM to conduct the initial review of 
said task letter. 

 

 After the value of the task letter has been confirmed, and if applicable, the task letter has been reviewed 
by PSS, PSS will return to the open tab in eBuilder and complete the “On-Call Information” section, 
adding the “Actual Consultant Fee” from the draft task letter and answer the question regarding the 
total value of the task letter assignment. 

 

 Upon completion, PSS will either select “Revise” from the drop-down list, next to the “Take Action” 
button, to return the task letter package to the previous step for PM revision or select “Submit” to 
forward the task letter package to the ADPM for review. After taking action, PSS will be prompted to 
provide a comment regarding the proposed revisions for the PM or a comment regarding the type of 
review the ADPM is to conduct prior to submitting the package to Legal. 

 

10.08 Task Letter Revision (PM) 
 

 If “Revise” was selected in the previous or consequent step, the task letter package is returned to the 
PM. The PM will receive an email notification from eBuilder that the task letter package has been 
returned and the task letter package will also appear in eBuilder under “My Processes” within the “My 
Home” tab in eBuilder. 

 

 The PM can either click on the email link to connect to the subject project process in eBuilder, or the PM 
can access the project process by logging into eBuilder, selecting the “My Home” tab, and clicking on the 
link in the “Instance” column for the subject project from the “My Processes” section. 
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 After gaining access to the project, within the task letter process, the PM should review the “Comments” 
tab for additional information regarding proposed revisions. 

 

 
 

 After reviewing the comments, the PM should re-open the “Details” tab and right click on the file folder 
project link provided in the “On-Call Selection Request” field, and select “Open Link in New Tab” to open 
the project file. The PM should review the proposed task letter revisions, and if applicable, accept said 
revisions and/or make additional revisions for resubmission. 

 

 
 

 ∗ User Tip – To get more accessibility when editing a Microsoft Word document in SharePoint, double 
click on the subject document to open it in SharePoint. After opening the document in SharePoint, 
make sure the dropdown list next to “Share” is in “Editing” mode and select “Open in Desktop App”. 
This will allow you to open the document in your desktop to make edits and those edits will 
automatically be save to the document in SharePoint. 
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 After completing the review, return to the open eBuilder tab, select “Submit” from the dropdown list 
and click on the “Take Action” button. 

 

10.09 ADPM Review (ADPM) 
 

 The ADPM will receive an email from eBuilder as notification that the task letter package has been 
forwarded to their attention to take action.  

To access the project process, either click on the link provided in the email or log into eBuilder, select the 
“My Home” tab and click on the subject project process link from the “My Processes” section.   

 

 

 
 

 After opening the project in eBuilder, select the “Comments” tab to note whether the task letter was 
initially reviewed by PSS for their review and submission to the Legal Director for final approval or if the 
ADPM is to conduct the initial review and submit the task letter package for legal for assignment and 
SPRB review. 

 

 
 

 After reviewing the comments, re-open the “Details” tab and then right click on the file folder project 
link provided in the “On-Call Selection Request” field, select “Open Link in New Tab” to open the project 
file to review the draft task letter, and if applicable, recommend additional revisions prior to submission 
to legal. 

 

 
 

 After completing the review, return to the open eBuilder tab, scroll down to the bottom of the page and 
either select “Revise” from the drop-down list next to the “Take Action” button to return the task letter 
package to PSS to complete the revision; or select “Submit” to forward the task letter package to the 
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Legal Director for final review and approval (>$100,000) or for assignment and SPRB Approval 
(<$100,000). 

 

 ∗ If “Revise” was selected, the ADPM will be prompted to provide a comment after clicking the “Take 
Action” button to provide direction for revising the task letter package for resubmission. 

 

10.10 Legal Assignment/SPRB Review or Legal Director Review (Legal Director) 
 

 If the cumulative value of all task letters is less than $100,000: 
 

 The Legal Director will receive an email from eBuilder as notification that the task letter package has 
been forwarded to their attention to take action.  

To access the project process, either click on the link provided in the email or log into eBuilder, select the 
“My Home” tab and click on the subject project process link from the “My Processes” section.   

 

 

 
 

 To review the task letter package, right click on the file folder project link provided in the “On-Call 
Selection Request” field and select “Open Link in New Tab”. The project file folder will open with the 
draft task letter package inside for review, and if applicable, revision. 

 
 

 
 

 After reviewing the comments, re-open the “Details” tab and then right click on the file folder project 
link provided in the “On-Call Selection Request” field, select “Open Link in New Tab” to open the project 
file to review the draft task letter, and if applicable, recommend additional revisions prior to submission 
to legal. 

 

 Upon completion of the task letter review, return to the open eBuilder tab and scroll down to the 
bottom of the page and either select “Revise” from the drop-down list next to the “Take Action” button 
to return the task letter package to PSS for additional revision or select “Submit” to forward the task 
letter package to PSS for processing through DocuSign (Step Eleven). 
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 If the cumulative value of all task letters is greater than $100,000: 
 

 The Legal Director will receive an email from eBuilder as notification that the task letter package has 
been forwarded to their attention to take action.  

To access the project process, either click on the link provided in the email or log into eBuilder, select the 
“My Home” tab and click on the subject project process link from the “My Processes” section.   

 

 After opening the project in eBuilder, answer the “Make Legal Assignment?” question by selecting “Yes” 
from the dropdown list and then will select “Submit” from the dropdown list next to the “Take Action” 
button and click the “Take Action” button to proceed to the next step. 

 

 

 
 

 After the “Take Action” button has been clicked, a prompt will be displayed to provide a comment, and a 
list of Attorney’s will be visible to select from for assignment. Click on the Attorney to be assigned, and 
then click on the “>” to move the Attorney from the “Available Users” to the “Selected Users” section 
and click “Submit” to make the assignment. 

 

 
 

10.11 OLAPP Review (OLAPP – Attorneys) 
 

 The OLAPP Attorney assigned to the project will receive an email from eBuilder as notification that the 
task letter package has been forwarded to their attention to take action.  
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 To access the project process, either click on the link provided in the email or log into eBuilder, select the 
“My Home” tab and click on the subject project process link from the “My Processes” section.   

 

 

 

 

 After opening the project process in eBuilder, select the “Comments” tab to note comments provided by 
previous actors in the process. 

 

 
 

 After reviewing the “Comments”, return to the “Details” tab, right click on the file folder project link 
provided in the “On-Call Selection Request” field, and select “Open Link in New Tab”. The project file 
folder will open with the draft task letter package inside for review, and if applicable, revision. 

 

 
 
 

 Upon completion of the task letter review, return to the open eBuilder tab and scroll down to the 
bottom of the page and either select “Revise” from the drop-down list next to the “Take Action” button 
to return the task letter package to PM for revision or select “Submit” to forward the task letter package 
to OLAPP Paralegals for submission to SPRB. 

 

10.12 SPRB Review (OLAPP - Paralegals) 
 

 The OLAPP Attorney assigned to the project will receive an email from eBuilder as notification that the 
task letter package has been forwarded to their attention to take action.  
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 To access the project process, either click on the link provided in the email or log into eBuilder, select the 
“My Home” tab and click on the subject project process link from the “My Processes” section.   

 

 

 

 
 

 After opening the project process in eBuilder, right click on the file folder project link in the “On-Call 
Selection Request” field and select “Open Link in New Tab” to access the task letter package. 

 
 

 
 

 Download the applicable task letter package for submission to SPRB and provide the “SPRB File Number” 
and the date “Sent to SPRB” under the section entitled “On-Call Information”. Then scroll down to the 
bottom of the page and click the “Take Action” button to proceed to the next step. 

 

 
 

 The subject task letter package will not be submitted to SPRB through eBuilder. The TL Package should 
be submitted to SPRB through normal means for their review. 

 

10.13 SPRB Approval (OLAPP - Paralegals) 
 

 After SPRB has completed their review, select the “My Home” tab again, and click on the link to the 
subject project from the “My Processes” section to open the process in eBuilder. Once opened, scroll 
down to the section entitled “On-Call Information” and provide the date “Approved by SPRB”, if 
applicable. Then, follow the “General Instructions” provided to “Approve”, “Revise”, or “Void” the task 
letter package and click on the “Take Action” button to proceed to the next step in the process. 
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10.14 Process Task Letter through DocuSign (OLAPP-Paralegals) 
 

 If “Approved” by SPRB, the task letter package will proceed to this placeholder step for the OLAPP 
Paralegal to process the task letter through DocuSign. 

 

 As was the case in the previous step, OLAPP Paralegals will receive an email from eBuilder as notification 
that the task letter package has been forwarded to their attention to take action and will appear under 
“My Home” tab in the “My Processes” section in eBuilder to take action. 

 

 Again, the OLAPP Paralegal can either click on the email link to connect to the project process in eBuilder 
or can click on the link to the subject project from the “My Processes” section, under the “My Home” 
tab, to connect to the project process (refer to diagrams in Step 11). 

 

 After opening the project process, the paralegal should right click on the file folder project link in the 
“On-Call Selection Request” field and select “Open Link in New Tab” to gain access to the task letter 
package file folder, download the final version of the subject task letter, and process the task letter 
through DocuSign. 

 

 After initiating the processing of the task letter through DocuSign, the paralegal should return to the 
open eBuilder tab, scroll down to the bottom of the page, select “Submit” from the dropdown list next 
to the “Take Action” button and click on the “Take Action” button. 

 

10.15 Process Task Letter through DocuSign (PSS) 
 

 PSS will receive an email from eBuilder as notification that the task letter package has been forwarded to 
their attention to take action and will appear under “My Home” tab in the “My Processes” section in 
eBuilder to take action. 

 

 PSS will access the project file folder, download the final version of the task letter and process the task 
letter through DocuSign. 

 

 After initiating the processing of the task letter through DocuSign, select “Submit” from the dropdown 
list next to the “Take Action” button and click on the “Take Action” button. 

 

10.16 Task Letter Executed (PSS) 
 

 PSS will receive an email from eBuilder as notification that the task letter has been processed through 
DocuSign. 

 

 PSS will access the project process, complete the “Task Letter Executed” section of eBuilder, upload a 
copy the executed task letter to the “Task Letter Executed” field for placement in the project file (Pre-
Construction/On-Call Task Letters), and select “Submit” to complete the task letter process. 
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Section 11: Contract and Amendment Process 
 

 THIS PROCESS IS CURRENTLY UNDER DEVELOPMENT 
 

11.01 Accessing the Process (OLAPP Procurement or PM) 
 

 Log in to e-Builder: https://gov.e-builder.net/auth/www/index.aspx?ReturnUrl=%2f 
 

 On your homepage, Go to the “Processes” tab and select the subject project for which you wish to draft 
a Contract or Amendment from the from the “All Projects” dropdown list. If the Contract or Amendment 
to be drafted is an On-Call, select “*Master On-Call” from the “All Projects” dropdown list. 

 

 Select “Contract and Amendment” from the “Type of Process” dropdown list and click “Start Selected 
Process Type”. 

 

11.02 Selecting the Contract Type (OLAPP Procurement or PM) 
 

 Select the type of Contract being submitted for approval from the “Contract Submission Type” dropdown 
list and click the “Take Action” button. 

 

11.03 Selecting the Document Type (OLAPP Procurement or PM) 
 

 Select the type of document being submitted for approval from the “Document Type” dropdown list and 
click the “Take Action” button. 

 
  

https://gov.e-builder.net/auth/www/index.aspx?ReturnUrl=%2f
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Section 11A: On-Call Contract Approval 
 

 THIS PROCESS IS CURRENTLY UNDER DEVELOPMENT 
 

11A.01 On-Call Contract Series Initiation (OLAPP Procurement) 
 

 Create an On-Call Contract Series file folder on the OneDrive by clicking on the following hyperlink: "On-
Call Consultant Services".  

 

 Hover the cursor over the file folder entitled “OC-DCS-(Series Number) and click on the ellipsis "...". 
 

 Select "Copy to" and then click “Copy here”. A prompt will appear “1 item wasn’t copied…”. Click “Keep 
both”. 

 

 Hover the cursor over the file folder entitled “OC-DCS-(Series Number)1 and click on the ellipsis "...". 
Select “Rename” and rename the newly pasted file folder with the subject On-Call Series Number, i.e. 
OC-DCS-ARC-0073-0078. 

 

 Hover the cursor over the renamed file folder and select “Copy link”. Paste the link in the "Contract 
Approval File Folder" field in the "On-Call Contract Series" section. 

 

 Provide data input for the remaining fields in “On-Call Contract Series” section. Upon completion of data 
input and after uploading the respective supporting documents, scroll down to the bottom of the page 
and press the "Take Action" button. 

 

 Note: If legal requires additional documentation and/or information regarding the subject On-Call 
Contract Series submission, OLAPP Procurement will receive an email from eBuilder as notification that 
additional documentation and/or information is required. 

To access the project process, either click on the link provided in the email or log into eBuilder, select the 
“My Home” tab and click on the subject project process instance link from the “My Processes” section. 

 

 

 
 
 

 

https://ctgovexec-my.sharepoint.com/:f:/r/personal/craig_russell_ct_gov/Documents/On-Call%20Forms%20%26%20Process/On%20Call%20Consultant%20Services?csf=1&web=1&e=JCKcD0
https://ctgovexec-my.sharepoint.com/:f:/r/personal/craig_russell_ct_gov/Documents/On-Call%20Forms%20%26%20Process/On%20Call%20Consultant%20Services?csf=1&web=1&e=JCKcD0
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 Click on the “Comments” tab to see what additional information or documentation is required.  
 

 
 

 If additional documentation is required, return to the “Details” tab and click on the link in the "Contract 
Approval File Folder" field to open subject On-Call Contract Series file folder. Upload the respective 
supporting documents to the “Supporting Documents” file folder and scroll down to the bottom of the 
page and press the "Take Action" button. 

If additional information is required, scroll down to the bottom of the page and press the "Take Action" 
button. 

After clicking the “Take Action” button a prompt will appear that will allow you to provide a comment 
regarding the request for additional documentation and/or information. After providing the comment, 
click “Submit”. 

 

 

 
 

 
 

11A.02 On-Call Contract Series Initiation (PSS) 
 

 PSS will receive an email from eBuilder as notification that the required documents have been submitted 
by DAS Procurement to initiate the drafting of a new On-Call Contract Series.  

To access the project process, either click on the link provided in the email or log into eBuilder, select the 
“My Home” tab and click on the subject project process instance link from the “My Processes” section.   
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 Refer to the "On-Call Contract Checklist" field in the “On-Call Contract Series” section for a list of the 
documents submitted.  

 

 Click on the link in the "Contract Approval File Folder" field to open subject On-Call Contract Series file 
folder. Open the "Supporting Documents" file folder to view the "On-Call Contract Checklist" documents. 

 

 Open the On-Call Selection Approval Memo on your desktop and return to the On-Call Contract Series 
file folder. Rename each of the individual On-Call Contract file folders, starting with the first number in 
the On-Call Contract Series and the first firm name from the On-Call Selection Approval Memo. Repeat 
this step until all of the firm names from the On-Call Selection Approval Memo have their own file folder. 

 

 Return to the process instance to complete the section entitled “On-Call Contract Data”. 
 

 Under the subsection entitled “Add New Item for On-Call Contract Data”, click the “Lookup” link in the 
“Vendor” field to lookup the first “Vendor” selected from the On-Call Selection Approval Memo, answer 
the remaining questions in the section, and click “Add”. Repeat this process for each selected Vendor. 
Upon completion, select “Send to Legal” from the dropdown list next to the “Take Action” button and 
click “Take Action”. 

 

 

 
 

11A.03 Legal Assignment (Legal Director) 
 

 The Legal Director will receive an email from eBuilder as notification that the required documents have 
been submitted by DAS Procurement to initiate the drafting of a new On-Call Contract Series.  

To access the project process, either click on the link provided in the email or log into eBuilder, select the 
“My Home” tab and click on the subject project process link from the “My Processes” section.   
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 Refer to the "On-Call Contract Checklist" field in the “On-Call Contract Series” section for a list of the 
documents submitted.  

 

 Click on the link in the "Contract Approval File Folder" field to open subject On-Call Contract Series file 
folder. Double click on the "Supporting Documents" file folder to view the "On-Call Contract Checklist" 
documents. 

 

 If additional documentation is required to initiate the drafting of said contract, scroll down to the bottom 
of the page and select "Return" from the dropdown list next to the "Take Action" button and then click 
the "Take Action" button. A prompt will appear to add a comment for the request of additional 
documentation. 

 

 If the necessary documentation has been submitted, scroll down to the bottom of the page and select 
"Submit" from the dropdown list next to the "Take Action" button and then click the "Take Action" to 
assign an Attorney and a Paralegal to draft the contract. 

 

 After the “Take Action” button has been clicked, a prompt will be displayed to provide a comment, and a 
list of Attorney’s and Paralegals will be visible to select from for assignment. Click on the name of the 
Attorney and Paralegal to be assigned, and then click on the “>” to move the Attorney and Paralegal 
from the “Available Users” to the “Selected Users” section. Click “Submit” to make the assignment. 

 

11A.04 Draft Contract/Credential Review (Attorney and/or Paralegal) 
 

 The Attorney and/or Paralegal assigned to draft the subject On-Call Contract Series will receive an email 
from eBuilder as notification that the required documents have been submitted by DAS Procurement to 
initiate the drafting of a new On-Call Contract Series.  

To access the project process, either click on the link provided in the email or log into eBuilder, select the 
“My Home” tab and click on the subject project process link from the “My Processes” section.   

 

 

 
 
 

 Refer to the "On-Call Contract Checklist" field in the “On-Call Contract Series” section for a list of the 
documents submitted.  
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 Click on the link in the "Contract Approval File Folder" field to open subject On-Call Contract Series file 
folder. Double click on the "Supporting Documents" file folder to view the "On-Call Contract Checklist" 
documents. 

 

 Complete data input for the “On-Call Checklist for Credential Review” field in the “On-Call Information” 
section. Upload copies of each of the respective documents checked off to the respective file folder 
listed in the field instructions. 

 

 Prepare a draft contract for the subject On-Call Contract Series. 
 

 Upon completion of the draft contract, click on the link in the "Contract Approval File Folder" field to 
open subject On-Call Contract Series file folder. Upload a copy of the draft contract to the “Drafts” 
subfolder within the subject On-Call Contract Series file folder. 

 

 After completing the draft contract, the data input, and after all of the required documents have been 
uploaded to the respective file folders, scroll down to the bottom of the screen and click the “Take 
Action” button to submit the draft to the Legal Director for review and approval.  

 

 Note: If all of the required documentation has not yet been submitted by selected firms by the time the 
draft On-Call Contract is ready for the Legal Director to review, you can proceed with clicking the “Take 
Action” button and finish the data input and uploading the required documents in step 11A.06 - Prepare 
On-Call Contract Packages for SPRB Review. 

 

11A.05 Legal Director Contract Review  
 

 The Legal Director will receive an email from eBuilder as notification that the draft contract for the 
subject On-Call Contract Series is ready to be reviewed.  

To access the project process, either click on the link provided in the email or log into eBuilder, select the 
“My Home” tab and click on the subject project process link from the “My Processes” section.   

 

 

 
 

 Click on the link in the "Contract Approval File Folder" field to open subject On-Call Contract Series file 
folder. Open the "Drafts" file folder to view the draft Contract. Open the “Credentials and Insurance”, 
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and “Supporting Documents” file folders to review such documents related to the On-Call Series 
Contract. 

 

 Review and revise the draft contract as needed. Upon completion of your review, scroll down to the 
bottom of the page and select one of the following from the dropdown list next to the "Take Action" 
button: 

 

 • Select "Return" and then click the "Take Action" button to return the draft to the Attorney 
and/or Paralegal assigned to the project for additional review and revision; or 

• Select "Submit" and then click the "Take Action" button to forward the process to Attorney 
and/or Paralegal assigned to the project to finalize the On-Call Contract for each of the selected 
firms and further prepare the On-Call Contract Series package for SPRB review.  

 

 After clicking the "Take Action" button, a prompt will appear to allow for comments related to the draft 
agreement and to again select the Attorney and/or Paralegal assigned to the project to complete the 
next step in the process. After providing your comments and making your selection, either click the 
"Return" or "Submit" button. 

 

11A.06 Prepare On-Call Contract Packages for SPRB Review (Attorney and/or Paralegal) 
 

 The Attorney and/or Paralegal assigned to the subject On-Call Contract Series will receive an email from 
eBuilder as notification that the Legal Director has completed a review of the draft contract and the 
Attorney and/or Paralegal can finalize the draft contract for each of the selected firms and begin 
preparing the On-Call Contract Series package for SPRB review.  

To access the project process, either click on the link provided in the email or log into eBuilder, select the 
“My Home” tab and click on the subject project process link from the “My Processes” section.   

 

 

 
 

 Complete data input for the “On-Call Checklist for Credential Review” and "On-Call SPRB Checklist" in the 
“On-Call Information” section. 

 

 Click on the link in the "Contract Approval File Folder" field, in the “On-Call Contract Series” section, to 
open the subject On-Call Contract Series file folder. Upload copies of each of the respective documents 
checked off in the “On-Call Checklist for Credential Review” and "On-Call SPRB Checklist" fields to the 
respective file folders listed in the field instructions.  
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Upload copies of the final draft Contract for each of the selected firms to the SPRB file folder and into the 
"Drafts" subfolder within each respective "On-Call Contract" file folder. 

 

 Complete data input for the “SPRB File No.” and “Date Sent to SPRB” fields in the “On-Call Contract 
Data” section. 

 

 To edit the above referenced fields for any given On-Call Contract, go to the row of the subject vendor; 
then scroll over to the column for the subject field and click on the "Pencil" toggle  ( ) to edit the field. 

 

 
 

 After completing the data input in the "On-Call Information" and "On-Call Contract Data" sections, and 
after all of the required documents have been uploaded to the respective file folders, scroll down to the 
bottom of the screen and click the “Take Action” button. 

 

11A.07 SPRB Approval/AG Review (Paralegal) 
 

 The Paralegal assigned to the subject On-Call Contract Series will receive an email from eBuilder as 
notification that the On-Call Contract series has been submitted to SPRB for review and approval. This 
will serve as a hold step until such time that the SPRB has reviewed and approved one or more of the 
subject On-Call Series Contracts.  

After SPRB has reviewed and approved one more of the subject On-Call Series Contracts, the Paralegal 
should proceed to process On-Call Series Contracts through DocuSign and prepare the Contracts for sign 
off by the Attorney General’s Office. A copy of each executed On-Call Contract should be sent to PSS 
upon completion. 

After sending the Contracts for sign off, the Paralegal should open the process instance in eBuilder for 
data input. 
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 To access the process instance, either click on the link provided in the email or log into eBuilder, select 
the “My Home” tab and click on the subject project process link from the “My Processes” section.   

 

 

 
 

 Follow the instructions provided under the “On-Call Contract Data” section and provide the “Date 
Approved by SPRB” and the “Date Sent to the AG” for each individual On-Call contract. Click on the 
“Pencil” toggle ( ) under the respective column header to provide the necessary data input. 

 

 
 

 After completing the data input for one or more On-Call Contracts, scroll down to the bottom of the page 
and click the "Take Action" button. 

 

 After clicking "Take Action", a prompt will appear to allow the Paralegal the opportunity to comment on 
the SPRB Review and Approval Process. If any of the subject On-Call Series Contracts were suspended or 
rejected, the Paralegal should provide a listing of those On-Call Contracts and the status of those 
contracts as being suspended or rejected in the "Comments" box. Upon completion, click "Submit". 
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 Note: If any of the subject On-Call Series Contracts were suspended or rejected, the data input for those 
respective Contracts will be input by PSS during the Final Review step. 

 

11A.08 Support Services Final Review (PSS) 
 

 PSS will receive an email from eBuilder as notification that an On-Call Contract Series has been submitted 
to the AG for approval. No action is required by PSS at this time. After one or more of the On-Call 
contracts has been processed through DocuSign and executed, the OLAPP – Paralegals will provide PSS 
with a copy of said contract(s). 

 

 Upon receipt of said contract(s), PSS should access the On-Call Contract Approval process by either 
clicking on the link provided in the email or by logging into eBuilder, selecting the “My Home” tab, and 
clicking on the link in the “Instance” column for the *Master On-Call project from the “My Processes” 
section.   

 

 After opening the On-Call Contract Approval process in eBuilder, select the “Comments” tab to note 
comments provided by previous actors in the process. 

 

 Select the “Documents” tab and upload copies of the executed On-Call Contracts. 
 

 Select the “Details” tab and follow the instructions provided under the section header “On-Call Contract 
Data” and provide data input for all of the remaining date fields, answer the “Document Uploaded?”, 
and provide the “CORE Contract No.” for each individual On-Call contract. 

 

 ∗ To edit the "Document Uploaded" field for any given On-Call Contract, go to the row of the subject 
vendor; then scroll over to the column for the subject field and click on the dropdown list within the 
field to select your response. To edit all other fields, click on the      “ “ toggle under the respective 
column header to provide the necessary data input. 

 

 After entering the data for one or more On-Call Contracts, scroll down to the bottom of the page and 
select "Create OC" from the dropdown list and click the "Take Action" button to proceed to the “On-Call 
Contract Creation – Cost Integrated” process. 

 

11A.09 On-Call Contract Creation – Cost Integrated (PSS) 
 

 PSS will receive an email from eBuilder as notification that one or more of the On-Call Contracts in the 
contract series has been executed and is ready to be set up as a Master Commitment. 

 

 To access the On-Call Contract Creation – Cost Integrated process, either click on the link provided in the 
email or log into eBuilder, select the “My Home” tab and click on the link in the “Process” column for the 
“Subject” - “On-Call … Series” from the “My Processes” section.   
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 Upon opening the On-Call Contract Creation – Cost Integrated process, a warning prompt will appear. 
Select the “Click here” link in the prompt to proceed to the next step and create the Master 
Commitment. 

 

 
 

 In the section entitled “Master Commitment Overview” section, provide data input for the following 
fields: 

 

 1. Master Commitment Type: Select “On-Call Contract” from the dropdown list. 

2. Company: Select the vendor from the dropdown list that is assigned to the On-Call Contract. 

3. Contact: Select a contact for the subject company from the dropdown list. 
 

 In the section entitled “Add New Master Commitment Item” section, provide data input for the following 
fields: 

 

 1. Account Code: Click the “ ” toggle.  

Select one of the following from the “Category” dropdown list: 

a. 10.0 – CA if the subject On-Call Contract is for CA, CA, or Cx services. 

b. 13.0 – Claims if the subject On-Call Contract is for ANLY or Audit services. 

c. 8.0 – A/E for all other On-Call Contract services. 

Select one of the following from the “Code” dropdown list: 

a. 10.130 – CA if the subject On-Call Contract is for CA, CA, or Cx services. 

b. 13.130 – Claims if the subject On-Call Contract is for ANLY or Audit services. 

c. 8.130 – A/E for all other On-Call Contract services. 

2. Amount: Input the Award amount for the subject On-Call Contract. 
 

 Complete the “Master Commitment Custom Fields” section in its entirety for each individual on-call 
contract that has been executed. Each individual on-call contract will be submitted separately. 

 

 Helpful Hints for completing the “Master Commitment Custom Fields” section 
 

 1. Return to the eBuilder webpage tab and select the “Processes” tab. 

2. Select “*Master On-Call” from the “All Projects” dropdown list. 

3. Click on the link under the “Subject” column header for the respective On-Call Contract Series. 
This will open the “On-Call Contract Creation – Cost Integrated” process page again. All of the 
subject On-Call Contract data for each individual On-Call contract will be visible under the “On-
Call Contracts” section. 

 

 After entering the On-Call Contract data, scroll down to the bottom of the page and select "Submit" from 
the dropdown list and click the "Take Action" button. 

 

 Return to the “Processes” tab and click on the link for the subject On-Call Contract Series. 
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 Answer the question “All Contracts Complete?” under the “On-Call Contract Series” section. Respond 
“No” to the question each time, until such time that all of the subject On-Call Contracts in the series have 
been executed and the data input has been completed for each contract. 

 

 Select “Complete” from the dropdown list next to the “Take Action” button and click “Take Action” each 
time an individual On-Call Contract is executed. 

 

 
 

 When prompted, insert the “Approval Date” and click “Yes, Approve”. 
 

 After all contracts have been executed and the data input for each individual contract has been 
completed, return to the “Processes” tab and click on the link in the “Instance” column for the *Master 
On-Call project one last time. 

 

 Answer the question “All Contracts Complete?” under the “On-Call Contract Series” section. Respond 
“Yes”, scroll down to the bottom of the page and select “Complete” from the dropdown list next to the 
“Take Action” button and click “Take Action” to complete the process. 
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Section 11B: Design Bid Build – DBB 
 

11B.01 (Coming Soon) 
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Section 11C: Construction Manager at Risk – CMR 
 

11C.01 (Coming Soon) 
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Section 11D: Design Bid Build – DBB 
 

11D.01 (Coming Soon) 
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Section 12: 1165 HazMat Project Intake Request 
 

12.01 Accessing the Process 
 

 Log in to e-Builder: https://gov.e-builder.net/auth/www/index.aspx?ReturnUrl=%2f  
 

 On your homepage, Go to the “Processes” tab and select the “*HazMat Project Creation Project” from 
the “All Projects” dropdown list. 

 

 
 

 Click the “Start Selected Process Type” button. The Type of Process should be listed as “1165 HazMat 
Project Intake Request (HAZ)”. 

 

 

12.02 Hazardous Materials Assistance Request (Agency PM) 
 

 Click the “Instructions” button at the top of the page for an overview of the Statewide Hazardous 
Abatement Program, general eBuilder instructions, and additional instructions for completing Form 
1165. In the “Subject” field, input the name of the project for which you are requesting HazMat 
Assistance. 

 

 

 
 

https://gov.e-builder.net/auth/www/index.aspx?ReturnUrl=%2f
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 ∗ If the name of the Agency PM is not listed in the dropdown list, please notify Craig Russell by email 
at craig.russell@ct.gov to have that individual added to the list and provide that individual with an 
eBuilder license, username, and password. 

 

12.03 HazMat Project Information (Agency PM) 
 

 Return to the “Processes” tab and click on the link for the subject project in the “Subject” column. 
 

 
 
 

mailto:craig.russell@ct.gov
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 Review the general instructions for and complete the sections entitled “Project Information” and 
“Emergency Use of HazMat Funds”. 

 

 
 

 ∗ Only answer “Yes” to the “Emergency Use of Funds” question if the subject project presents a 
condition that is an immediate threat to the health and safety of any persons, and/or disrupts the 
normal operation of the agency (or portions thereof) and requires the commencement of hazmat 
services within a twenty-four (24) hour period. 

 

 Upon completion, scroll down to the bottom of the page and select “Submit” from the dropdown list 
next to the “Take Action” button and click the “Take Action” button. If you answered “Yes” to the 
“Emergency Use of Funds” question, proceed to Section 12.04. If you answered “No”, proceed to Section 
12.05. 
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12.04 HazMat Emergency Project (Agency PM) 
 

 If the response to the “Emergency Use of Funds” question was “Yes”, return to the “Processes” tab and 
click on the link for the subject project in the “Subject” column. The “Step” column should denote the 
subject project as “Agency Emergency Project”. 

 

 
 

 Click the “Instructions” button at the top of the page for an overview of the processing of emergency 
HazMat project requests. 

 
 

 

 

 Review the general instructions for and complete the sections entitled “Services Requested”, 
“Emergency Consultant/Contractor”, “Statement of Verification” and “Terms of Acceptance & 
Signature”. 
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 To complete the “Emergency Consultant/Contractor” section, scroll down to subsection “Add New Item 
for Emergency Consultant/Contractor” and select the “Preferred Consultant/Contractor” from the 
dropdown list provided and provide the “Preferred Consultant/Contractor Quote”. Select “Other” from 
the dropdown list if your selected Consultant/Contractor is not formally listed. After providing the 
information for the first Consultant/Contractor, click the “Add” button and repeat this process if 
applicable. 

 

 

 

 If “Other” was selected from the “Preferred Consultant/Contractor” dropdown list, then provide the 
name of the Consultant/Contractor and the proposed fee in the “Other Consultant/Contractor” section. 

 

 

 After adding the Emergency Consultant/Contractor, answer the “Estimated Fee Known” question by 
selecting “Yes” or “No” from the dropdown list. 

 

 

 

 • Answer “Yes” if the estimated fee is known for all "Preferred Consultant/Contractor"(s).  
• Answer “No” if the estimated fee is unknown for either the Consultant or Contractor and  leave the 

"Preferred Consultant/Contractor Quote" field blank. 
 

 ∗ Please note that if no fee was provided at the time of submission, you will have 24 hours after 
the work has started to acquire a rough estimate from the Consultant and/or Contractor for the 
services that are to be provided. sufficient time to assess and gain a better understanding of the 
emergency project, so that a rough estimate can be provided. 
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 After responding the “Estimated Fee Known?” question, complete the sections entitled “Statement of 
Verification” and “Terms of Acceptance and Signature”. 

 

 Upon completion of all sections, scroll down to the bottom of the page and select “Submit” from the 
dropdown list next to the “Take Action” button and click the “Take Action” button. 

 

 The Client Agency may begin work immediately after notifying DAS/CS of the emergency project through 
the submission of Form 1165. Pre-approval is not required to initiate the work on an emergency project. 

 

 If the client agency answered "No" to the "Estimated Fee Known?" question, then the client agency will 
receive an email notification through eBuilder that action is required by the client agency to complete 
the application. 

 

 To access the application, the client agency can either click on the link provided in the email or log into 
eBuilder, select the “My Home” tab and click on the link in the “Instance” column for the “*HazMat 
Project Creation Project” from the “My Processes” section. The “Step” column should read “Emergency 
Fee”. 
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 To add the rough estimate, click on the " " icon in the column entitled "Preferred Consultant/Contractor 
Quote", next to the name of the respective Consultant/Contractor, and input the estimated fee. Repeat 
this action for each Consultant/Contractor. 

 

 

 
 

 Upon completion, scroll down to the bottom of the page and click the "Take Action" button to submit 
the application to the DAS Supervising Environmental Analyst for review and for sign off on the 
application. 

 

 After the application has been signed and executed, the client agency will receive an email notification 
from eBuilder with a copy of the executed Form 1165. 

 

 
 

 At the conclusion of the emergency project, the consultant/contractor shall provide an itemized invoice 
for time and materials for services performed, and payment will be made in accordance with the 
approved rates in the appropriate state contracts. DAS/CS reserves the right to reject payment at the 
discretion of the DAS Chief Architect. 
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 This concludes the HaMat Application process for emergency projects for the client agency in eBuilder. 
 

12.05 HazMat Services Requested (Agency PM) 
 

 If the response to the “Emergency Use of Funds” question was “No”, return to the “Processes” tab and 
click on the link for the subject project in the “Subject” column. The “Step” column should denote the 
subject project as “Agency HazMat Service Request”. 

 

 
 

 Review the General Instructions for and complete the sections entitled “Services Requested”, 
“Environmental Consultant Services”, “Abatement Contractor Services”, “Other Consultant/Contractor” if 
applicable, “Preferred Consultant/Contractor”, “Service Justification” if applicable, “Work Plans & Cost 
Estimates”, and “Terms of Acceptance & Signature”. 
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 To complete the “Environmental Consultant Services” and “Abatement Contractor Services” sections, 
scroll down to the subsection entitled “Add New Item for…” in those respective sections and select one of 
the “Environmental Consultants” and or “Abatement Contractors” solicited from the dropdown list and 
provide said “Environmental Services Quote” and/or “Abatement Contractor Quote”.  Click the “Add” 
button and repeat this process for all Consultants/Contractors solicited. 

 

 
 

 If the Consultant and or Contractor is not in the respective dropdown list, select “Other” from the 
respective dropdown list and provide the name of said Consultant/Contractor and their proposed fee in 
the “Other Consultant/Contractor” section. 
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 Complete the same steps noted above for the “Preferred Consultant/Contractor” section, adding only 
the “Preferred Consultant/Contractor” and their respective quotes. 

 

 
 

 If the “Preferred Consultant/Contractor” is not the low bid, complete the “Service Justification” section. 
 

 Complete the “Work Plans & Cost Estimates” section by first reviewing the instructions. After reviewing 
the instructions, scroll back up to the top of the page, click on the “Documents” tab, and then click the 
“Attach Documents” button. 

 

 
 

 Once prompted, select “Upload from your Computer”, click “HazMat Application” as the destination 
folder and press the “Select” button. 

 

 

 

 Upload the required documents into the space provided. Please note that the upload process may be 
delayed. 

 

 Upon completion of the upload, click on the “Details” tab to return to the application.  Scroll down to the 
end of the application and complete the section entitled “Terms of Acceptance and Signature”. 

 

 Upon completion of all sections, select “Submit” from the dropdown list next to the “Take Action” button 
at the bottom of the page, and click the “Take Action” button. 

 

 After the Supervising Environmental Analyst reviews the application for approval, the client agency will 
receive an email notification through eBuilder that either the application will need to be revised to be 
considered for approval, or the request has been approved and assigned.   
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 To access the application after the Environmental Analyst has completed his review, the client agency 
can either click on the link provided in the email or log into eBuilder, select the “My Home” tab and click 
on the link in the “Instance” column for the “*HazMat Project Creation Project” from the “My Processes” 
section. The “Step” column should read “Agency Project Info”. 

 

 
 

 
 

 After opening the application in eBuilder, scroll down to the bottom of the page and review the section 
entitled “Consultant/Contractor Approval and Assignment”. 

 

 
 

 If the application was rejected, the field entitled “Assignment Comments” will provide the reason for 
rejection and instructions for corrective action, if applicable. 
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 After reviewing the “Assignment Comments”, revise the application in accordance with the comments. 
Upon completion, scroll down to the bottom of the page and click the “Take Action” button to resubmit 
your application. 

 

 If the application was approved,  follow the same process noted above to access the application. After 
opening the application in eBuilder, scroll down to the bottom of the page to the section entitled 
“Consultant/Contractor Approval and Assignment” and review the field entitled “Assignment Comments”. 
This will serve as the notification to the client agency and the assigned consultant/contractor that the 
application has been approved and the Supervising Environmental Analyst will follow up with the 
respective parties to schedule a scope review meeting. 

 

 The process is similar for the recommendation of the Notice to Proceed.   
 

 After the Supervising Environmental Analyst provides a recommendation for the Notice to Proceed, the 
client agency will receive an email notification through eBuilder that either the application has been 
submitted to the DAS Authorized Authority for signature or that the application will need to be revised 
before it can be considered for recommendation. 

 

 If the application is rejected, the client agency should access the application by either clicking on the link 
provided in the email or log into eBuilder, select the “My Home” tab and click on the link in the 
“Instance” column for the “*HazMat Project Creation Project” from the “My Processes” section. The 
“Step” column should read “Agency Project Info” (see sample diagrams above for illustrations regarding 
accessing the application). After opening the application in eBuilder, scroll down to the bottom of the 
page and review the section entitled “Notice to Proceed Recommendation” and refer to the field 
entitled “Notice to Proceed Comments” for an explanation of rejection and instructions for corrective 
action, if applicable. 

 

 After reviewing the “Notice to Proceed Comments”, revise the application in accordance with the 
comments. Upon completion, scroll down to the bottom of the page and click the “Take Action” button 
to resubmit your application. 

 

 If the application is recommended for a Notice to Proceed, the application will be forwarded to the DAS 
Authorized Authority to sign-off on the project. After the application has been signed and executed, the 
client agency will receive an email notification from eBuilder with a copy of the executed Form 1165. 

 

 
 

 This concludes the HaMat Application process for the client agency in eBuilder. 
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12.06 DAS Approval & Assignment (Environmental Analyst – DAS Only) 
 

 The Environmental Analyst will receive an email from eBuilder as notification that the HazMat Assistance 
Request has been submitted for DAS Approval and Assignment. 

 

 To access the project process, either click on the link provided in the email or log into eBuilder, select the 
“My Home” tab and click on the link in the “Instance” column for the “*HazMat Project Creation Project” 
from the “My Processes” section.  The “Step” column should read “DAS Approval & Assignment”. 

 

 

 
 

 
 

 Review the application submission under the “Details” tab. To review any comments provided on the 
application submission, click on the “Comments” tab. To review any supporting documents submitted 
with the application, click on the “Documents” tab. 
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 After reviewing the application submission, scroll down to the sections entitled “Consultant/Contractor 
Approval & Assignment” and “Project Status Summary”, review the general instructions for and 
complete those sections. 

 

 
 

 

 

 Upon completion of all sections, scroll down to the bottom of the page and select either “Approve”, 
“Reject”, or “Void”  from the dropdown list next to the “Take Action” button and click the “Take Action” 
button. 

 

 If “Approve” was selected, you will be prompted to “Add users for review and comment”, which will 
allow access to the submitted Form 1165 to those selected users for review and comment. Select the 
approved consultant/contractor from the list of “Available Users” to grant them access to review the 
application and receive notification that a scope review meeting is to be scheduled. 
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 If “Reject” was selected, Form 1165 will be returned to the client agency for revision, if applicable. 
 

12.07 Emergency Assignment/NTP (Environmental Analyst – DAS Only) 
 

 The Environmental Analyst will receive an email from eBuilder as notification that an Emergency HazMat 
Assistance Request has been submitted for DAS Review and Processing. 

 

 To access the project process, either click on the link provided in the email or log into eBuilder, select the 
“My Home” tab and click on the link in the “Instance” column for the “*HazMat Project Creation Project” 
from the “My Processes” section.  The “Step” column should read “Emergency Assignment/NTP”. Please 
refer to the diagrams in Section 12.0.6 DAS Approval & Assignment for a visual representation on 
accessing the process. 

 

 Review the general instructions and complete the “Emergency Assignment”, “Notice to Proceed 
Recommendation”, and ”Project Status Summary” sections. 

 

 When completing the “Emergency Assignment” section (see diagram on the next page): 

a) Select “Emergency” from the dropdown list for the fields entitled “Environmental Consultant 
Request” and “Abatement Contractor Request”; 

b) Input the names and quotes provided by the client agency from the “Preferred 
Consultant/Contractor” section into the respective “Approved” consultant, contractor and fee 
fields.  

c) The “Project Name” field should consist of the following: “HazMat Project Number – HazMat 
Project Name” as listed under “Subject” at the top of the page, i.e. 24-CSCU-HAZ-01 - HazMat 
Test Project 8.  

d) Select Craig Russell as the “eBuilder Project Administrator”. 

Select Matthew Pafford as the “Project Manager” of the HazMat Program. 
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 When completing the “Project Status Summary” section, select “Active” from the dropdown list for 
“Project Status”. 

 

 
 

 Upon completion of all sections, scroll down to the bottom of the page and select “Recommend” from 
the dropdown list next to the “Take Action” button and click the “Take Action” button. 

 

 After clicking the “Take Action” button, you will be prompted to “Add actors to the next step”, which will 
direct the application to the Authorized Authority to sign off on the approval of the application; and to 
“Add users to review and comment”, which will allow selected users access to the submitted Form 1165 
for review and comment. 

 

 To add an actor to act as the Authorized Signatory, select the individual’s name from the list of “Available 
Users” for which you wish to sign off on the application, then click on the “>” to move that individual 
into “Selected Users”. 

 

 
 

 Repeat this process to “Add users for review and comment”. Select the “Approved” Consultant and/or 
Contractor from the list of “Available Users” so that they can receive notification that the application is 
being processed and to allow them access to the application for review and comment. After adding the 
actors and users, click the “Recommend” button. Proceed to Section 12.10 Form 1165 Executed. 

 

12.08 Scope Review/NTP Recommendation/Project Assignment (EA – DAS Only) 
 

 The “Scope Review/NTP/Project Assignment” step should not be completed until after the scope review 
meeting has been scheduled and completed. 

 

 After the scope review meeting, the Environmental Analyst can access the project process by either clicking 
on the link provided in the aforementioned email or by logging into eBuilder, selecting the “My Home” tab 
and clicking on the link in the “Instance” column for the “*HazMat Project Creation Project” from the “My 
Processes” section.  The “Step” column should read “Scope Review/NTP/Project Assignment”. Please refer 
to the diagrams in Section 12.06 DAS Approval & Assignment for a visual representation on accessing the 
process. 
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 Review the general instructions and complete the “Scope Review”, “Consultant/Contractor Approval & 
Assignment”, “Notice to Proceed Recommendation”, “Project Assignment”, and ”Project Status 
Summary” sections. 

 

 ∗ When completing the “Project Assignment” section, the “Project Name” should consist of the 
following: “HazMat Project Number – HazMat Project Name” as listed under “Subject” at the top of 
the page, i.e. 24-CSCU-HAZ-01 - HazMat Test Project 8. Select Craig Russell as the “eBuilder Project 
Administrator”. Select Matthew Pafford as the “Project Manager” of the HazMat Program. 

 

 
 

 ∗ When completing the “Project Status Summary” section, select “Active” from the dropdown list for 
“Project Status”. 

 

 
 

 If “Recommend” was selected, you will be prompted to “Add actors to the next step”, which will direct 
the application to the Authorized Authority to sign off on the approval of the application. 

 

 To add a user, select the individuals name from the list of “Available Users” for which you wish to sign off 
on the application, then click on the “>” to move that individual into “Selected Users” and click the 
“Recommend” button. 

 

 
 

 If “Reject” was selected, Form 1165 will be returned to the client agency for revision, if applicable. 
 

12.09 Project Authorization (Chief Architect/Deputy Commissioner – DAS Only) 
 

 Either the Chief Architect or the Deputy Commissioner will receive an email from eBuilder as notification 
that the HazMat Assistance Request has been submitted for Project Authorization. 

 

 To access the project process, either click on the link provided in the email or log into eBuilder, select the 
“My Home” tab and click on the link in the “Instance” column for the “*HazMat Project Creation Project” 
from the “My Processes” section. 
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 Review the application submission under the “Details” tab. To review any comments provided on the 
application submission, click on the “Comments” tab. To review any supporting documents submitted 
with the application, click on the “Documents” tab. 

 

 
 

 To review comments specific to the “Recommendation for Notice Proceed”, scroll down to the section 
entitled “Notice to Proceed Recommendation” and refer to the field entitled “Notice to Proceed 
Comments”. 

 

 
 
 



 
0175 e-Builder Guidance Manual 

Page 109 of 199 
 

CT DAS 0175 (Rev. 03.07.2024) 0000 Guidance Manuals 
 

 After completing your review of the application submission, scroll down to the section entitled “Project 
Authorization”, review the general instructions for and complete that section. 

 

 
 

 Upon completion of all sections, scroll down to the bottom of the page and select either “Approve” or 
“Reject” from the dropdown list next to the “Take Action” button and click the “Take Action” button.   

 

 If "Reject" was selected, you will be prompted to provide a comment to explain the reason for rejection 
and to provide guidance for corrective action. After providing the comment, click the “Reject” button. 

 

 
 

 If "Approve" was selected, the application will be sent to the Environmental Analyst to formalize the 
submission and an email will be distributed through eBuilder to the client agency that includes a copy of 
the executed Form 1165. The executed Form 1165 will also be uploaded to the eBuilder “HazMat 
Application” project file folder. 

 

12.10 1165 Executed (Environmental Analyst – DAS Only) 
 

 The Environmental Analyst will receive an email from eBuilder as notification that the HazMat Assistance 
Request has been executed. 

 

 To access the project process, either click on the link provided in the email or log into eBuilder, select the 
“My Home” tab and click on the link in the “Instance” column for the “*HazMat Project Creation Project” 
from the “My Processes” section.  

 

 

 
 



 
0175 e-Builder Guidance Manual 

Page 110 of 199 
 

CT DAS 0175 (Rev. 03.07.2024) 0000 Guidance Manuals 
 

 
 
 

 A PDF of the Form 1165 submission will be visible in the “Form 1165 Executed” field. 
 

 
 

 If no work plans or cost estimates were provided with the application submission, and/or if the subject 
project is an emergency project for which additional documentation was provided, those documents 
should be uploaded now 

 

 To add these documents, click on the "Documents" tab, near the top of the page, and then click the 
"Attach Documents" button to begin the process. 

 

 
 

 Once prompted, select “Upload from your Computer”, click “HazMat Application” as the destination 
folder, and press the “Select” button. 

 

 

 

 

 Upload the required documents into the space provided. Please note that the upload process may be 
delayed. 
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 Upon completion of the upload, click on the “Details” tab to return to the application, then scroll down 
to the bottom of the page and click the “Take Action” button to complete the HazMat Project Intake 
Request Process. 

 

 After clicking the “Take Action” button, a prompt will appear that will allow you the opportunity to 
provide a comment regarding the executed 1165, and will allow you to select the HazMat contacts that 
are to be assigned to the subject project to review and comment on the submission and to be assigned a 
role on the project. Upon completion, click "Submit” 

 

 
 

 
 

 ∗ Please note that the executed Form 1165 and all other documents uploaded as part of the 1165 
Project Intake Request Process will be uploaded to the *HazMat Project Creation Project/HazMat 
Application file folder. These files will need to be moved to the respective project file folder upon 
completion of the 1165 Project Intake Request Process. 

 

12.11 Project Files (Environmental Analyst – DAS Only) 
 

 To access the *HazMat Project Creation Project/HazMat Application file folder, go to the “Projects” tab 
and select the *HazMat Project Creation Project from the “All Projects” dropdown list. 

 

 

 
 



 
0175 e-Builder Guidance Manual 

Page 112 of 199 
 

CT DAS 0175 (Rev. 03.07.2024) 0000 Guidance Manuals 
 

 Next, select “Documents” from the “Project Menu” on the lefthand side of your screen. After selecting 
“Documents”, click on the “HazMat Application” file folder to access the newly executed Form 1165 and 
any other documents that were uploaded as part of the 1165 Project Intake Request Process. Then, 
check the box(es) of the files that you want to move to the newly created HazMat Project file folder. 
Next click the “Move” hyperlink to move the selected project files. 

 

 
 

 After clicking the “Move” hyperlink, you will be given a prompt to move the project files. Select the 
project name for the newly created HazMat Project from the dropdown list. Then click on the “HazMat 
Application” file folder. 

 

 
 

 After clicking the “HazMat Application” file folder hyperlink, you will be given a prompt asking, “Are you 
sure you want to move the selected files…”; press “OK”. 
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 Another prompt will pop up stating that “The following file(s) will be moved to…”; click “Continue”. 
 

 
 

 The document(s) have now been moved to the project file folder. 
 

 To access the newly created HazMat Project/HazMat Application file folder, go to the “Projects” tab and 
select the name of the newly created project from the dropdown list, i.e. 24-CSCU-Hazmat-900 – HazMat 
Test Project (refer to the diagram at the beginning of Section 12.11 Project Files). 

 

 Next, select “Documents” from the “Project Menu” on the lefthand side of your screen. After selecting 
“Documents”, click on the “HazMat Application” file folder to access the newly executed Form 1165 and 
any other documents that were moved from the *HazMat Project Creation Project to the newly created 
HazMat Project. 
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Section 13: HazMat Commitment 
 

13.01 Accessing the Process 
 

 Log in to e-Builder: https://gov.e-builder.net/auth/www/index.aspx?ReturnUrl=%2f  
 

 On your homepage, Go to the “Processes” tab and select the hazmat project number for the project for 
which you want to make against from the “All Projects” dropdown list. 

 

 
 

 Click the “Start Process” button and select the “HazMat Commitment” link. 
 

 
 

13.02 HazMat Commitment 
 

 Read the “General Instructions”, fill in the “Subject” field in accordance with the instructions and click 
the “Submit” button. 

 

 After clicking “Submit”, you will be returned to the “Processes” tab. Click on the link to the project listed 
in the “Subject” column. 

 

 

https://gov.e-builder.net/auth/www/index.aspx?ReturnUrl=%2f
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 Read the “General Instructions”, revise the Consultant/Contractor Information, if applicable, and click 
the “Take Action” button. 

 

 After clicking “Take Action”, you will be returned to the “Processes” tab. Click on the link to the project 
listed in the “Subject” column again to spawn the cost integration for the commitment process. 

 

13.03 HazMat Cost Integration 
 

 When spawning the commitment process, you will receive a “Warning” notification. Click on the link 
within the warning notification to access the cost integrated process where you can enter the 
commitment details for the subject HazMat project. 

 

 
 

 Begin the HazMat Cost Integrated process by completing the “Commitment Details” section. Under 
“Commitment Details”, go to the “Master Commitment” field and select the Master Commitment 
Contract, from the dropdown list, for either the “Approved Environmental Consultant” or “Approved 
Abatement Contractor” listed under the Consultant/Contractor Information section. 

 

 ∗ This process will be repeated at a later stage if there are multiple Consultant / Contractor(s) listed 
within the Consultant/Contractor Information section. 

 

 
 

 After selecting the Master Commitment Contract, all of the remaining fields in the “Commitment Details” 
section will infill automatically, but for the “Contact” field for the company. You may leave this field 
blank, or you may select a contact from the dropdown list. Please note that the contact is specific to the 
contract, not to the project. 

 

 After completing the “Commitment Details” section, scroll down to the “Commitment Custom Fields” 
section and input the “CORE Contract No.” for the subject Consultant/Contractor and the “PO Number” 
assigned to the CORE Contract. 

 

 
 



 
0175 e-Builder Guidance Manual 

Page 116 of 199 
 

CT DAS 0175 (Rev. 03.07.2024) 0000 Guidance Manuals 
 

 

 Then, scroll down to the “Add New Commitment Item” section.  Click on the link in the “Master 
Commitment Item” field and then click on the “Item Number” link under “Master Commitment Items”. 

 

 Next, input the dollar amount of the approved fee for the subject Consultant/Contractor in the 
“Amount” field and click the “Add” button. Upon completion, scroll down to the bottom of the page and 
click the “Submit” button. 

 

 
 

 After clicking “Submit”, you will be returned to the “Processes” tab. First, click on the “Reset filters” link. 
  

 

 Then, click on the project link in the “Subject” column to return to the HazMat Commitment Process (The 
“Step” column should read “Commitments Complete?”). 

 

 
 

 Read the HazMat Commitment(s) instructions, answer the “All Commitments Entered” question and click 
the “Take Action” button. 

 

 
 

 If you answered “No” to the question, you will be returned to the “Processes” tab. Click on the project 
link under the “Subject” column to spawn the commitment process again (The “Step” column should 
read “Spawn Commitment”) . Repeat Step 13.02 until all commitments have been entered. 
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 If you answered “Yes” to the question, the commitment process will be completed. The commitment 
status will be marked as “Pending”, so that the line item can be adjusted if necessary. The commitment 
status will need to be “Approved”, prior to payment. 

 

13.04 Edit or Approve a HazMat Commitment 
 

 Click on the “Projects” tab and select “HazMat Projects View” from the View dropdown list. 
 

 
 

 Click on the link in the “Project Name” column to access the HazMat Project Details page. 
 

 After opening the HazMat Project Details page, select “Cost” from the “Project Menu” and then select 
“Commitments” under the Cost dropdown list. This will open the Commitments display page, which will 
show all commitments related to that project. 

 

 
 

 Click on the link in the “Description” column to access the “Commitment Details” page for the line item 
commitment you wish to edit or approve. 
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 After opening the “Commitment Details” page, you can either click the “Approve” button, if you wish to 
approve the commitment as is, or click the “Edit” button if you wish to edit the commitment amount. 

 

 
 

 If the “Edit” button was clicked, then scroll down to the section entitled “Commitment Items” and scroll 
over to the column entitled “Amount”. Click on the “Pencil” toggle to edit the commitment amount. 
Upon completion, scroll down to the bottom of the page and click the “Save” button. 

 

 
 

 After saving your changes, you can either click the “Approve” button, if you wish to approve the 
commitment, or closeout of the “” page until such time that you wish to approve the commitment. 
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Section 14: 6010 Bid Release Form 
 

14.01 Accessing the Form 
 

 Log in to e-Builder: https://gov.e-builder.net/auth/www/index.aspx?ReturnUrl=%2f 
 

 On your homepage, find your project by clicking on the top tab for “Projects”: 
 

 

 Search for your project by entering the project number. Click on your project to bring up the “Project 
Details” page. 

 

 
 

 The “Project Details” page is your home page for your project.  (Click “Edit” to edit info.). Under the 
“Project Menu” on the left, click on Processes to find project-specific processes. 

 

 

 

https://gov.e-builder.net/auth/www/index.aspx?ReturnUrl=%2f
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 Click on “Start Process” to find and start a process. 
 

 
 

 Click on “6010 Bid Release Form (6010)” to begin the process. 
  

 
 

 Read the first page and then click on “Submit”. 
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14.02 Project Manager Instructions for Entering Bid Release Form Information: 
 

 On the Processes page, if you cannot find the process, check the boxes for “Draft”, “Open”, and 
“Finished”, and click on “Filter”. This should show you the process for 6010. 

 

 
 

 On the Processes page for the Project, click on the process for 6010. 
 

 
 

 Read the “Bid Release Form Instructions”. 
 

 Upload all files indicated with a red asterisk (*). 
 

 
 

 Enter all Bid Information as instructed.  Any items indicated with a red asterisk (*) are required. 
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 For Supplemental Bids and Named Subcontractors, follow the instructions in the process. Once the Bid 
Information has been entered, you have three options: 

 

 1. Save as a Draft: Select “Save”. 

2. Perform Final Review Prior to Submitting to the Procurement Unit: Click on “Please select an action”, 
select “Review”, then click on “Take Action”. 

3. Delete this Process: Click on “Please select an action”, select “Void”, then click on “Take Action”.  

NOTE: You will LOSE all of the information you have input and will NOT be able to return to this page. 
 

 

 
 

14.03 Project Manager Instructions for Reviewing the Bid Release Form Information: 
 

 From the Processes page for the Project, click on the process for 6010. Review the Bid Information.  If the 
information is correct and complete, you have three options: 

 

 1. Save as a Draft: Select “Save”. 
2. Submit to the Procurement Unit: Click on “Please select an action”, select “Submit”, then click on 

“Take Action”.  
3. Delete this Process: Click on “Please select an action”, select “Void”, then click on “Take Action”. 

 

 The process is then in Procurement Unit’s ball court. 
 

 
 

14.04 Procurement Unit Instructions for Bid Release Form: 
 

 Read the instructions. Download the files. Review the Bid Information. 
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 At the bottom (or top) of the page, click on “Please select an action” and select “Approve” or “Revise”. 
Then click on “Take Action”. The process is then in the ADPM’s ball court. 

 

 
 

14.05 ADPM Instructions for Bid Release Form: 
 

 Read the instructions. Review the Bid Information. 
 

 Click on “Please select an action” and select “Approve” or “Revise”. Then click on “Take Action”. The 
process is then in the Chief Architect’s ball court. 
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14.06 Chief Architect Instructions for Bid Release Form: 
 

 Read the instructions. Select Yes or No for Priority Project. Review the bid information. Click on “Please 
select an action” and select “Approve” or “Revise”. Then click on “Take Action”. 

 

 
 

14.07 6010 Mail Merge: 
 

 When the 6010 Bid Release Form has been reviewed and approved by the Procurement Unit, the ADPM, 
and the Chief Architect, the 6010 Bid Release Form “mail merge” will be generated as a PDF document 
and emailed to everyone as indicated at the beginning of the process. 

 

 The 6010 Mail Merge will also be saved in the following e-Builder Documents folder: 
Documents > 08 Bidding > DAS Procurement 

 

 Once the 6010 Mail Merge step is complete, the process is in the Procurement Unit’s ball court. 
 

14.08 Procurement Unit Instructions for Pre-Bid Meeting Information: 
 

 Enter the Date of the Bid Advertisement and the Planned Date of the Bid Advertisement Ending. Select 
“Send” and “Take Action” to forward the process to the Project Manager. 

 

 The process is then in the Project Manager’s ball court, who will have three (3) days to enter the Pre-Bid 
Meeting Information and re-submit back to the Procurement Unit. 
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14.09 Project Manager Instructions for Pre-Bid Meeting Information: 
 

 Enter the Pre-Bid Meeting Information and send the process back to Bidding within three (3) days by 
selecting “Send” and “Take Action”. The process is then in the Procurement Unit’s ball court. 

 

 
 

14.10 Procurement Unit Instructions for Reviewing the Pre-Bid Meeting Information: 
 

 Review the Pre-Bid Meeting Information. You have three options: 
 

 1. Select “Save” to save as a draft. 

2. If the information is correct, select “Go To Wages” and “Take Action” to enter the dates that the 
Prevailing Wages were requested from the Department of Labor. 

3. If edits are required, select “Revise” and “Take Action” to send the process back to the Project 
Manager. 
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14.11 Procurement Unit Instructions for Prevailing Wage Rates: 
 

 NOTE: Instructions are provided in e-Builder for requesting Prevailing Wage Rates from the Department 
of Labor.  The request itself is conducted separately from e-Builder.  E-Builder is only used to track the 
dates that the wage rates were requested and the dates they were received. 

 

 Enter the Date Requested and (if available) Date Received. Select either “Refresh Screen” (to view the 
date that the wage rates are due) or “Go To Bid” to view Bid Information from the Project Manager and 
to begin entering additional Bid Information. 

 

 
 

14.12 Procurement Unit Instructions for Bidding Information: 
 

 NOTE: After Pre-Bid Meeting Information and Prevailing Wages Request Information has been entered, 
the Procurement Unit arrives at the final Bid Information page. The Procurement Unit will insert the 
Unique Solicitation Number and use the information to complete the Invitation to Bid and Bid Proposal 
Form outside of e-Builder. The Procurement Unit will also enter the Actual Date that the Bid 
Advertisement ends as well as the Number of Addendum for the Solicitation. 

 

 Follow the instructions on the e-Builder page in order to enter information and dates. Select “Refresh 
Screen” and “Take Action” at the bottom (or top) of the page in order to update Automatic Fields. 
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14.13 Procurement Unit Instructions for 6010 Bid Release Form Closeout: 
 

 Once the Project has gone into construction (or the Bid is cancelled/no award), close the e-Builder 6010 
Bid Release Form process by selecting “Closeout” and “Take Action”. 

 

 NOTE: “Closeout” will permanently close the process – do NOT select this option if the process is still 
open. 
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Section 15: (Reserved for future instructions) 
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Section 16: (Reserved for future instructions) 
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Section 17: GC / CMR - Create Schedule of Values 
 

17.01 SOV Approval for Upload 
 

 Project Support Services (PSS) uploads SOVs into e-Builder commitments upon request of the DAS 
project manager for that project. Please submit a request for the project manager to ask PSS to carry out 
the upload of the file described in Section 17.02, below. 

 
 

17.02 SOV file format 
 

 When sending the SOV for upload, please follow the following format: 
 

 1. Use Excel, another similar spreadsheet format or CSV. Please do not send it in PDF, Word or similar 
file formats. 

2. If the file is Excel or another spreadsheet, the data should be in a single sheet, not divided between 
two or more sheets. 

3. Ensure that each SOV row has at least columns for (1) description or title and (2) SOV dollar amount. 
A row line number is permitted, as well. 

4. Do not have any blank rows. 

5. If it is desired to have rows that are section titles, please place this title in the description column and 
place a $0 in the amount column. 
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Section 18: Consultant and General Vendor Invoice 
 

18.01 Access the project Process 
 

 Log in to e-Builder: https://gov.e-builder.net. On your homepage, find your project by clicking on the top 
tab for “Projects”: 

 

 
  

 Search for your project by entering the project number. Click on your project to bring up the “Project 
Details” page. 

 

 
  

 The “Project Details” page is your home page for your project. Under the “Project Menu” on the left, 
click on Processes to find project-specific processes. 

 

 

https://gov.e-builder.net/
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 18.02 Initiate the invoicing Process. 
 

 Click on “Start Process” to find and start a process. 
 

 
  

 A/E users then click on “A/E Invoice (InvAE)” to begin the process. Users from other consultant types 
click the equivalent process, including “CA Invoice (InvCA)”, “CMR Pre-Construction Invoice (CMpre)”, 
“Other Consultant Invoice (InvOt)” or “Hazmat Invoice (InvHz)” 

 

 
 

 Proceed as follows to complete the consultant Invoice form: 
 

 1. Either drag and drop the invoice into the “Drag and drop file here” or click “Browse Computer” to 
locate and upload the file. For other supporting documentation, a second upload block is available. 

2. Select the applicable vendor commitment. Take care to select the correct commitment if the vendor 
has more than one task on the project. Once selected, note that the “Invoice Items” part populates. 

3. Enter the vendor’s invoice number and the beginning and end dates for the invoice. 
4. Click on the “0.00” or pencil icon the “Invoice Amount” column and enter the amount of the invoice. 
5. When the invoice form is correct, click “Submit” to submit the invoice to the project manager. The 

“Save Draft” button is available to save the form as a draft and return later. 
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 18.03 Invoices Returned for Revision 
 

 Once the form is submitted, the project manager may return it to the vendor if changes are needed. 
 

 
 

 Clicking on that will remove the current document, and a replacement can then be uploaded in its place. 
 

 After the needed changes are made, note, at the top and bottom of the pop-up, that there are workflow 
action controls. 

 

 
 

 By clicking “Please select an action” the user can select what action is intended on the invoice. 
 

 The option to “Resubmit” will appear and, if that is the intended action, select that. There is also an 
option to “Void”, which has the effect of closing review of the invoice and voiding the invoice process 
instance. 

 

 When the action is selected, clicking on the “Take Action” button finalizes the user’s action and sends the 
item to the next user in the workflow, if the “Resubmit” option is taken, or ends the workflow with no 
payment, if the “Reject” option is taken. 
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Section 18A: PM Review of Consultant & Vendor Invoice 
 

18A.01 Access the Project Process 
 

 Log in to e-Builder: https://gov.e-builder.net. On your homepage, find your project by clicking on the top 
tab for “Projects”: 

 

 
  

 Search for your project by entering the project number. Click on your project to bring up the “Project 
Details” page. 

 

 
  

 The “Project Details” page is your home page for your project. Under the “Project Menu” on the left, 
click on Processes to find project-specific processes. 

 

 

https://gov.e-builder.net/
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18A.02 Locate the Process Instance 
 

 Click on the Projects tab and then open the project by clicking on the project name. 
 

 
 

 Next, click on the Processes module under the Project Menu and click on the Filters icon. 
 

 
 

 Under the Filters control, click “search processes”. Then, click on the consultant type invoice that is to be 
reviewed, i.e. “A/E Invoice (InvAE)”, “CA Invoice (InvCA)”, etc.  

 

 
 

 Click on the process instance number for the pending invoice, which should appear in the “PM Approve” 
step. It will also appear as “Open” in the State column. 
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18A.03 Key Items for PM Review 
 

 Key items for PM Review include: 
 

 A. Click on the filename to cause a pop-up window to appear that has the vendor’s invoice. 
B. Under “Commitment Invoice Details”, it is important to make sure that the vendor is invoicing their 

own company and the correct commitment, if they have more than one commitment on the 
project. 

C. Vendor invoice number, and beginning and end dates are requested for the Business Office. 
D. The Invoice Amount needs to be entered correctly for the e-Builder record to be accurate. 
E. Select one of the following for payment of the invoice: 

a. Select “Business Office” to send the invoice automatically to the Business Office to be 
paid when the PM Approves the invoice, as described in items F and G, below. 

b. Select “Agency” to send the invoice to the appropriate agency to pay expenses on a 
project. If the “Agency” is paying the invoice, the person processing these payments will 
need to be added to the Agency Payor role on the project. 

F. The Action pull down menu allows the PM to select Approve, Revise or Void. 
a. “Approve” causes the invoice, with a cover sheet noting that the PM has determined 

that it is OK to Pay, to be sent to the Business office or agency for payment, depending 
on what was selected in item E, above. 

b. “Revise” sends the invoice back to the vendor for any needed corrections. The PM will be 
prompted to enter comments for the vendor about what needs to be corrected. 

c. “Void” ends consideration of the invoice. 
G. After the Action to be taken is selected, the Take Action button causes that Action. 
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Section 18B: Hazmat Invoice Instructions for Agencies 
 

18B.01 Access the Project Process 
 

 HazMat Invoices require review and approval by agencies. Agency staff will receive an email notification 
from eBuilder that an invoice is pending. To access the pending invoice, the agency can either click on 
the link in the email and the browser instance will appear as a pop-up.  

 

 
 

 or the agency can log in to e-Builder: https://gov.e-builder.net/auth/www/index.aspx?ReturnUrl=%2f 
and click on the “Projects” tab to find the applicable project.  

 

 

 Search for your project by entering the project number. Click on your project to bring up the “Project 
Details” page. 

 

 
 

 The “Project Details” page is your home page for your project.  (Click “Edit” to edit info.). Under the 
“Project Menu” on the left, click on Processes to find project-specific processes. 

 

 

https://gov.e-builder.net/auth/www/index.aspx?ReturnUrl=%2f
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 1. Change the Process filter settings to find the process instances you are looking for. In this case, 
switch Type of Process to “Hazmat Invoice (InvHz)”. Selecting All Processes will show all instances, 
regardless of whose ball-in-court the instances are in. Draft, Open or Finished status can be 
selected, as well. 

2. The filtered list appears here. Click on the instance you wish to open. A pop-up will open. That is the 
process instance. 

 

 
 

18B.02 Invoice Review 
 

 Regardless of which route used to access it, when the pop-up for the invoice process instance appears, 
review the invoice information. 
1. Click on the document name in the “Vendor Invoice Document” field. A viewer pop-up will appear, 

allowing review of the vendor’s invoice document. There may be supporting materials attached to 
this document or in “Addition Invoicing Documentation” field. 

 

 
 

 2. Documentation may also be uploaded into the Documents tab of the process instance. Review all 
documentation in each of these locations. 

 

 
 

 3. In the “Invoice Items” section, scroll to the right until the “Invoice Amount” column is seen. This is 
where the vendor should have entered the correct invoice amount. If there is more than one invoice 
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row, the correct amount should be in each row and the correct total for the invoice should appear in 
the gray summary row at the bottom. 

 

 
 

18B.03 Invoice Approval 
 

 If the information included in the invoice process instance is correct, and the agency wishes to approve, 
doing so involves two steps. 

1. The first step is to select the “Agency Approver” and the approval date. 
 

 
 

 2. Then, at the top and bottom of the pop-up, there are workflow action controls. 
 

 
 

 3. By clicking “Please select an action” the user can select what action is intended on the invoice. The 
option to “Approve” will appear and, if that is the intended action, select that. There is also an option 
to “Reject”, which has the effect of closing review of the invoice and voiding the invoice process 
instance. 

 

 4. When the action is selected, clicking on the “Take Action” button finalizes the user’s action and sends 
the item to the next user in the workflow, if the “Approve” option is taken, or ends the workflow 
with no payment, if the “Reject” option is taken. 
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Section 19: 7390 Application and Certification for Payment 
 

19A GC & CMR Users 
 

19A.01 Instructions for the GC/CMR for creating and submitting Payment Applications: 
 

 Log in to e-Builder: https://gov.e-builder.net. On your homepage, find your project by clicking on the top 
tab for “Projects”: 

 

 
  

 Search for your project by entering the project number. Click on your project to bring up the “Project 
Details” page. 

 

 
  

 The “Project Details” page is your home page for your project. Under the “Project Menu” on the left, 
click on Processes to find project-specific processes. 

 

 
 
 

https://gov.e-builder.net/
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 Click on “Start Process” to find and start a process. 
 

 
 

 Click on “7390 Application and Certification for Payment (7390A)” to begin the process. 
 

 
 

19A.02 Complete the Payment Application Form 
 

 In the “Counter Prefix” field, enter the Payment Application number of this payment application. 
 

 
 

 Carefully read and follow the instructions provided. 
 

 Upload supporting documentation for the Payment Application to the Documents tab. Click on the tab 
header to access the tab. Either drag-and-drop the documents to the tab or click the “Attach” button. 

 

 
 

 If the “Attach” button is clicked, a pop-up will appear. Click “Upload from your Computer” to locate a 
locally stored document. 
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 Then, click “Select” to use the pre-selected default folder (highlighted in blue font) as the destination 
folder in the eBuilder Documents module to upload the supporting documents. If applicable, an 
alternate folder can be selected.  

 

 
 

 Then click “Browse”. 
 

 
 

 Select the file(s) you wish to upload and click “Open”. 
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 If it worked properly, you should see a green line under where the filename is. Then click “Done.” 
 

 
 

 

 The uploaded document should then appear in the Documents tab. Also note the number in parentheses 
next to the “Documents” tab title, indicating the number of uploaded files. 

 

 
 

 Complete the rest of the Payment Application Form as follows: 
 

 1. First group of questions after the blue instructions area. 
a. Ensure that all required documentation is attached, as described above, and then acknowledge 

that it is in the field here. 
b. Select who the contractor’s approver is in that field. This is the person whose name will appear 

in the signature block on the PDF copy of the Application and Certification for Payment, signing 
on behalf of the contractor. 

c. Indicate whether securities in lieu of retainage is being used and, if so, the amount. 
2. Select the correct commitment for the vendor. Take care to select the correct commitment if the 

vendor has more than one on the project. Once selected, note that the “Invoice Items” part of the 
form populates. 

3. Enter the vendor’s own invoice number and the beginning and end dates of the period being 
invoiced. This information is required. 

4. Click on the “0.00” or pencil icon in the “This Period” column and enter the amount of the current 
invoice in each line. 

5. If stored materials are being used, update each relevant row with the amount of current stored 
materials as of this Payment Application. In subsequent Payment Applications, when those amounts 
are to be used, reduce this amount and add the amount reduced to the amount billed in that 
Payment Application under This Period for that row. 



 
0175 e-Builder Guidance Manual 

Page 144 of 199 
 

CT DAS 0175 (Rev. 03.07.2024) 0000 Guidance Manuals 
 

6. If there is any retainage release for this Payment Application, enter the amount released for each 
row under Retainage Release Amount. (If there is a need to change retainage percentages, please 
communicate that to the DAS Project Manager.) 

 

 
 

 When the invoice form is correct, click “Submit” to submit the invoice to the into the workflow for 
review. The “Save Draft” button is available to save the form as a draft and return later. 

 

19A.03 Payment Application Form Returned for Revision 
 

 A payment application may be returned for revision. If the pay application is returned, the Actor having 
submitted the application will receive an email notification that the application has been returned for 
revision. The email will appear as follows and include the following information: 
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 1. Process Details show the project, process type the notice concerns and the step the workflow is 
presently in, as of the notification. 

2. The Comments section has comments from the workflow and other information. 
3. There are links, top and bottom. Clicking on the link, of you are logged into e-Builder, will open the 

process instance pop-up. 
 

 
 

 Comments explaining the reasons for the return information on the actions needed may be included in 
the Documents tab: 

 

 
 

 Or the Comments tab: 
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 Make the needed changes, and then the Payment Application process instance can be resubmitted 
forward in the workflow by selecting Submit from the action menu on the top or bottom of the form and 
clicking “Take Action”. There is also an option to void the Payment Application. 

 

 
 

19B CA Users 
 

19B.01 Instructions for the CA for Review and Certification of Payment Applications: 
 

 Log in to e-Builder: https://gov.e-builder.net. On your homepage, find your project by clicking on the top 
tab for “Projects”: 

 

 
  

 Search for your project by entering the project number. Click on your project to bring up the “Project 
Details” page. 

 

 
  

 The “Project Details” page is your home page for your project. Under the “Project Menu” on the left, 
click on Processes to find project-specific processes. 

 

 
 

https://gov.e-builder.net/
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 Change the Process filter settings to find the process instances you are looking for.  
1. Select “7390 Application and Certification for Payment” from the “Search Processes” dropdown 

menu. Select one or more of the following from the “Filter by” dropdown menu: “All Processes”, 
“Draft”, “Open”, or “Finish”. “All Processes” will show all process instances for the subject project, 
regardless of whose ball-in-court the instances are in. Draft, Open or Finished status can be selected, 
as well. 

2. The filtered list will appear as displayed below. Click on the instance you wish to open. A pop-up will 
open of the process instance selected. 

 

 
 

 Once the process instance opens, review all of the information entered, including the files uploaded to 
the Documents tab. To view the pencil requisition, click the “Details tab” and then click on the link to the 
PDF, as shown below: 
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 After reviewing the pencil requisition, return to the “Details” tab and: 
1. Select whether the payment is to be issued by the DAS Business Office or by the client agency. If 

there is any question about this, consult with the DAS Project Manager. 
2. The CA should then select their firm name from the “CA Reviewer” dropdown list and the input the 

date of approval. 
 

 
 

 At the top and bottom of the form are pull-down menus that allow the user who is ball-in-court to select 
the action they need to take on the item. “Submit” will send the item to the A/E for review. “Revise” will 
send the item back to the GC/CMR for any corrections that are needed. Once the action to be taken is 
selected, click the “Take Action" button. 

 

 
 

 If “Revise” was selected, a comment screen will appear which, in this case, is required. After comments 
are entered into the space provided, click “Revise” to complete and send the comments. 
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19B.02 Other Items for Verification 
 

 Under Cost > Commitments, in the Custom Fields tab of each commitment, please check to ensure that 
the PO Number field is the correct purchase order number, especially for DAS Business Office invoicing. 
(The number “0000000000” is a placeholder and is not an actual PO Number.) This is important to 
ensure that the DAS Business Office is able to process payments without them being held up by 
uncertainly about the what purchase order to use for payment. 

 

 
 

19C A/E Users 
 

19C.01 Instructions for the A/E for Review and Certification of Payment Applications: 
 

 Log in to e-Builder: https://gov.e-builder.net. On your homepage, find your project by clicking on the top 
tab for “Projects”: 

 

 
  

 Search for your project by entering the project number. Click on your project to bring up the “Project 
Details” page. 

 

 

https://gov.e-builder.net/
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 The “Project Details” page is your home page for your project. Under the “Project Menu” on the left, 
click on Processes to find project-specific processes. 

 

 
 

 Change the Process filter settings to find the process instances you are looking for.  
1. Select “7390 Application and Certification for Payment” from the “Search Processes” dropdown 

menu. Select one or more of the following from the “Filter by” dropdown menu: “All Processes”, 
“Draft”, “Open”, or “Finish”. “All Processes” will show all process instances for the subject project, 
regardless of whose ball-in-court the instances are in. Draft, Open or Finished status can be 
selected, as well. 

2. The filtered list will appear as displayed below. Click on the instance you wish to open. A pop-up will 
open of the process instance selected. 

 

 
 
 



 
0175 e-Builder Guidance Manual 

Page 151 of 199 
 

CT DAS 0175 (Rev. 03.07.2024) 0000 Guidance Manuals 
 

 Once the process instance opens, review all of the information entered, including the files uploaded to 
the Documents tab. To view the pencil requisition, click the “Details tab” and then click on the link to the 
PDF, as shown below: 

 

 
 

 The A/E should then select their firm name from the “AE Approver” dropdown list and the input the date 
of approval. 

 

 
 

 At the top and bottom of the form are pull-down menus that allow the user who is ball-in-court to select 
the action they need to take on the item. “Submit” will send the item to the A/E for review. “Revise” will 
send the item back to the GC/CMR for any corrections that are needed. Once the action to be taken is 
selected, click the “Take Action" button. 

 

 
 

 If “Revise” was selected, a comment screen will appear which, in this case, is required. After comments 
are entered into the space provided, click “Revise” to complete and send the comments. 
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19D PM Users 
 

19D.01 Instructions for the PM for Review and Certification of Payment Applications: 
 

 Log in to e-Builder: https://gov.e-builder.net. On your homepage, find your project by clicking on the top 
tab for “Projects”: 

 

 
  

 Search for your project by entering the project number. Click on your project to bring up the “Project 
Details” page. 

 

 
  

 The “Project Details” page is your home page for your project.  
 

19D.02 Project set-up on Payment Applications whose costs are paid for by the Agency 
 

 If the Agency is directly responsible paying payment applications, the person who attends to the 
payment must be in the Agency Payor role. If that person is not in that role, please request that Project 
Support Services (Tim O’Brien) place that person in that role. 

 

 
 

https://gov.e-builder.net/


 
0175 e-Builder Guidance Manual 

Page 153 of 199 
 

CT DAS 0175 (Rev. 03.07.2024) 0000 Guidance Manuals 
 

 If the payment will be made using CHEFA funds, proceed as follows: 
 

 1. At the top of the Project Details page, click “Edit”. 
 

 
 

 2. Select “Yes” on the line that asks, “Is this a CHEFA  project.” 
 

 3. Enter the CHEFA series number for the Payment Application cover letter. 
 

 4. Enter the agency reviewer for the signature page on the cover letter. 
 

 5. Click “Save.” 
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19D.03 Accessing the Process Instance 
 

 Under the “Project Menu” on the left, click on Processes to find project-specific processes. 
 

 
 

 Change the Process filter settings to find the process instance you are looking for.  
1. Select “7390 Application and Certification for Payment” from the “Search Processes” dropdown 

menu. Select one or more of the following from the “Filter by” dropdown menu: “All Processes”, 
“Draft”, “Open”, or “Finish”. “All Processes” will show all process instances for the subject project, 
regardless of whose ball-in-court the instances are in. Draft, Open or Finished status can be 
selected, as well. 

2. The filtered list will appear as displayed below. Click on the instance you wish to open. A pop-up will 
open of the process instance selected. 
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 Once the process instance opens, review all of the information entered, including the files uploaded to 
the Documents tab. To view the pencil requisition, click the “Details tab” and then click on the link to the 
PDF, as shown below: 

 

 
 

 The PM should then select their firm name from the “PM Approver” dropdown list and the input the 
date of approval. 

 

 
 

 At the top and bottom of the form are pull-down menus that allow the user who is ball-in-court to select 
the action they need to take on the item. “Submit” will send the item to the A/E for review. “Revise” will 
send the item back to the GC/CMR for any corrections that are needed. Once the action to be taken is 
selected, click the “Take Action" button. 

 

 

 The project manager will then be prompted to approve the payment for the project Cost part of e-
Builder and enter the Approved date. 

 

 
 

 If “Revise” was selected, a comment screen will appear which, in this case, is required. After comments 
are entered into the space provided, click “Revise” to complete and send the comments. 
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Section 20: Request for Information 
 

 

 

20.01 GC/CMR RFI Submission - Accessing the Process 
 

 Log in to e-Builder: https://gov.e-builder.net. On your homepage, find your project by clicking on the top 
tab for “Projects”: 

 

 
  

 Search for your project by entering the project number. Click on your project to bring up the “Project 
Details” page. 

 

 
  

 The “Project Details” page is your home page for your project. Under the “Project Menu” on the left, 
click on Processes to find project-specific processes. 

 

 

https://gov.e-builder.net/
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 Click on “Start Process” to find and start a process. 
 

 
 

 A pop up will appear with processes that the user is able to initiate. Select “7310 Request For 
Information (7310)” from the list of available process types. 

 

 
 

 That causes the pop-up to change into the RFI form. Complete the answers to the questions asked in the 
form. 

 

 
 

 Click on the “Documents” tab header to open the tab. Upload supporting documents for the RFI to the 
Documents tab by either using the “drag-and-drop” feature or by clicking the “Attach” button. 
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 If the “Attach” button is clicked, a pop-up will appear. Click the “Upload from your Computer” button to 
locate a locally stored document. 

 

 
 

 Then, click “Select” to use the pre-selected default folder (highlighted in blue font) as the destination 
folder in the eBuilder Documents module to upload the supporting documents. If applicable, an 
alternate folder can be selected.  

 

 
 

 Then click “Browse”. 
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 Select the file(s) you wish to upload and click “Open”. 
 

 
 
 
 

 If it worked properly, you should see a green line under where the filename is. Then click “Done.” 
 

 
 

 The uploaded document should then appear in the Documents tab. Also note the number in parentheses 
next to the “Documents” tab title, indicating the number of uploaded files. 

 

 
 

 If the user would like to save the RFI, and keep it in draft form for future editing, the “Save Draft” button 
is available. 
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 The RFI is saved as a type of e-Builder “Process instance”. 
 

 To locate the draft Process instance that is the draft RFI, go back into the project, and open the Processes 
module within the project. 

 

 
 

 Proceed as follows to change the Process filter settings to find the process instance you are looking for:.  

1. Select “7310 Request for Information (7310)” from the “Search Processes” dropdown menu. Select 
one or more of the following from the “Filter by” dropdown menu: “All Processes”, “Draft”, “Open”, 
or “Finish”. “All Processes” will show all process instances for the subject project, regardless of 
whose ball-in-court the instances are in. Draft, Open or Finished status can be selected, as well. 

2. The filtered list will appear as displayed below. Click on the instance you wish to open. A pop-up will 
open of the process instance selected. 

 

 
 

 When the user is ready to submit the RFI, click “Submit”. This will cause the RFI to be sent into workflow. 
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20.02 CA RFI Review - Accessing the Process 
 

 The CA will receive an email notification from eBuilder that an RFI is pending. To access the pending RFI, 
the CA can either click on the link in the email and the browser instance will appear as a pop-up; or  

 

 
 

 the CA can log in to e-Builder: https://gov.e-builder.net/auth/www/index.aspx?ReturnUrl=%2f and click 
on the “Projects” tab to find the applicable project.  

 

 

 Search for your project by entering the project number. Click on your project to bring up the “Project 
Details” page. 

 

 
 

 The “Project Details” page is your home page for your project.  (Click “Edit” to edit info.). Under the 
“Project Menu” on the left, click on Processes to find project-specific processes. 

 

 
 

 Proceed as follows to change the Process filter settings to find the process instance you are looking for:  

1. Select “7310 Request for Information (7310)” from the “Search Processes” dropdown menu. Select 
one or more of the following from the “Filter by” dropdown menu: “All Processes”, “Draft”, “Open”, 

https://gov.e-builder.net/auth/www/index.aspx?ReturnUrl=%2f
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or “Finish”. “All Processes” will show all process instances for the subject project, regardless of 
whose ball-in-court the instances are in. Draft, Open or Finished status can be selected, as well. 

2. The filtered list will appear as displayed below. Click on the instance you wish to open. A pop-up will 
open of the process instance selected. 

 

 
 

 Once the process instance opens, the CA can review all of the information entered, including the files 
uploaded to the “Documents” tab, and any comments made regarding the RFI under the “Comments” 
tab. The CA will then return to the “Details” tab and provide a response to the editable questions. The 
CA has the option to “Save” its edits and return for further edits, if it so chooses, by clicking the “Save” 
button. 

 

 
 

 At the top and bottom of the form are pull-down menus that allow the user who is ball-in-court to select 
the action they need to take. “Submit” will forward the RFI to the A/E for review. “Revise” will return the 
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RFI to the GC/CMR for any corrections that are needed. Once the action to be taken is selected, click the 
“Take Action" button to complete the action. 

 

 
 

 If “Revise” was selected, a comment screen will appear which, in this case, is required. After comments 
are entered into the space provided, click “Revise” to complete and send the comments. 

  

 
 

20.03 A/E RFI Review - Accessing the Process 
 

 The A/E will receive an email notification from eBuilder that an RFI is pending. To access the pending RFI, 
the A/E can either click on the link in the email and the browser instance will appear as a pop-up; or  

 

 
 

 the A/E can log in to e-Builder: https://gov.e-builder.net/auth/www/index.aspx?ReturnUrl=%2f and click 
on the “Projects” tab to find the applicable project.  

 

 

 Search for your project by entering the project number. Click on your project to bring up the “Project 
Details” page. 

 

 
 

https://gov.e-builder.net/auth/www/index.aspx?ReturnUrl=%2f
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 The “Project Details” page is your home page for your project.  (Click “Edit” to edit info.). Under the 
“Project Menu” on the left, click on Processes to find project-specific processes. 

 

 
 

 Proceed as follows to change the Process filter settings to find the process instance you are looking for:  

1. Select “7310 Request for Information (7310)” from the “Search Processes” dropdown menu. Select 
one or more of the following from the “Filter by” dropdown menu: “All Processes”, “Draft”, “Open”, 
or “Finish”. “All Processes” will show all process instances for the subject project, regardless of 
whose ball-in-court the instances are in. Draft, Open or Finished status can be selected, as well. 

2. The filtered list will appear as displayed below. Click on the instance you wish to open. A pop-up will 
open of the process instance selected. 
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 Once the process instance opens, the A/E can review all of the information entered, including the files 
uploaded to the “Documents” tab, and any comments made regarding the RFI under the “Comments” 
tab. The A/E will then return to the “Details” tab and provide a response to the editable questions. The 
A/E has the option to “Save” its edits and return for further edits, if it so chooses, by clicking the “Save” 
button. 

 

 
 

 At the top and bottom of the form are pull-down menus that allow the user who is ball-in-court to select 
the action they need to take. “Respond” will forward the RFI to for final determination. “Return” will 
return the RFI to the CA for any corrections that are needed. “Send to Sub” will forward the RFI to the 
sub for review and comment. Once the action to be taken is selected, click the “Take Action" button to 
complete the action. 

 

 
 

 If “Return” was selected, a comment screen will appear which, in this case, is required. After comments 
are entered into the space provided, click “Return” to complete and send the comments. 

  

 

Return 
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 When the “Send to Sub” option is selected, a comment screen will appear, with an “Add Comment” for 
the A/E to give instructions to their subconsultants, and an “Add actors to the next step” to select the 
subconsultant(s) to which the RFI is to be referred.  

 

 To add a subconsultant to the next step, the A/E will select the subconsultant’s name from the list of 
“Available Users” column and then click the “>” to move that individual into the “Selected Users” 
column. After adding a comment and selecting the user, click “Send to Sub.” 

 
 

 
 
 

 As an alternative to the “Send to Sub”, it may be preferable to go to the “Comments” tab of the RFI 
instance and click the “Request Comment” button. Using this “Request Comment” method allows the 
A/E to maintain control of the item in workflow, rather than giving the subconsultant control in the 
workflow. 

 

 
 

 After clicking the “Request Comment” button, a pop-up will appear that allows the A/E to select their 
subconsultant users in the “To” field by selecting their names and pressing the arrow button to move 

Jim Johnson 
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them to the right panel. The “Message” field allows the A/E user to provided instructions to the 
subconsultants. Then the “Request Comment” button sends a comment request notification to the 
subconsultant. 

 

 
 

 When the subconsultant responds, their comments will be posted in the “Comments” tab of the RFI 
instance. 
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20.04 CA Determination 
 

 After the A/E completes their review, the RFI will be forwarded to the CA for final determination. To 
access the RFI instance, the CA should follow the steps outlined in Section 20.02 to open the process 
instance. 

 

 Once the process instance opens, the CA can review all of the information entered, including the files 
uploaded to the “Documents” tab, and any comments made regarding the RFI under the “Comments” 
tab. The CA will then return to the “Details” tab and provide a response to the editable questions. 

 

 
 

 At the top and bottom of the form are pull-down menus that allow the CA to select the action they need 
to take. The CA can either select “Determination” or “Return”. “Send Code Unit” is also listed as an 
option, but should not be used at this time. After making a selection, click the “Take Action” button. 

 

 
 

 If the CA selects “Return”, the RFI will be returned to the A/E with instructions for correction 
 

 If the CA selects “Determination” and answered “Yes” to the “Is there a Potential Cost Impact” question, 
then the RFI workflow will generate a Proposal Request, as part of a “Potential Change Order (PCO)” 
process instance. 
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20.05 A/E Proposal Request Step 
 

 After the CA makes a final determination on an RFI that was identified as having a potential cost impact, 
the A/E will receive an email notification to that effect. To access the RFI instance, the A/E should follow 
the steps outlined in Section 20.03 to open the process instance. 

 

 Once the process instance opens, the CA can review all of the information entered, including the files 
uploaded to the “Documents” tab, and any comments made regarding the RFI under the “Comments” 
tab. The CA will then return to the “Details” tab and provide a response to the editable questions. 

 

 The purpose of the RFI process instance at this step is to launch a Proposal Request instance. After 
opening the process instance, note the “Warning” banner at the top of the page. The only action the A/E 
should take is to click the “Click here” link in the banner. DO NOT click “Take Action” at this step. 

 

 
 

 After clicking “Click here,” an instance of the “Potential Change Order (PCO)” process type will be 
launched. This is an entirely new process type and an entirely new process instance. The “Potential 
Change Order (PCO)” is the umbrella name for a process that begins with Proposal Requests and may 
generate into CCDs and/or COPs. See the instructions for the “Potential Change Order (PCO)” process for 
how to proceed with this process. 

 

 Note that the RFI’s workflow process will be automatically completed when the Submit button is pressed 
by the A/E user in the Proposal Request part of the “Potential Change Order (PCO)” process, meaning 
that no further action needs to be nor should be taken by users on the RFI. 
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Section 21: Proposal Requests 
 

21.01 Coming Soon 
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Section 22: CCDs 
 

22.01 Coming Soon 
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Section 23: COPs 
 

21.01 Coming Soon 
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Section 24: Change Orders  
 

21.01 Coming Soon 
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Section 25: Submittals 
 

25.01 Accessing the Process 
 

 Log in to e-Builder: https://gov.e-builder.net/auth/www/index.aspx?ReturnUrl=%2f and click on the 
“Projects” tab to find the applicable project.  

 

 

 Search for your project by entering the project number. Click on your project to bring up the “Project 
Details” page. 

 

 
 

 The “Project Details” page is your home page for your project.  (Click “Edit” to edit info.). Under the 
“Project Menu” on the left, click on Processes to find project-specific processes. 

 

 
 

 

https://gov.e-builder.net/auth/www/index.aspx?ReturnUrl=%2f
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25.02 Submittals Settings (Project Manager or CA) 
 

 Before the Submittals begin on a project, click on the settings option for Submittals. 
 

 
 

 Ensure that the Offset Type setting is set to “Calendar Days.” Then select one or more CA staff as 
Submittal Coordinators by clicking on their names and then clicking the right arrow button. 
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 Set “General Contractors for Submissions” to “GCs” or “CMRs”, ensure that the other settings are correct 
and click Save. 

 

 
 

25.03 Filter Functionality 
 

 The processing of Submittals and Submittal Packages involves the changing of their status, as discussed, 
below. Users can filter the Submittal Register and the list of Submittal Packages using the eBuilder filters.  

 

 There are a number of filter criteria that are available. These include the ability to toggle different 
statuses. Select, for example, “Open” and “Draft” to filter only for submittals that have been submitted 
or have not been submitted yet; or select “Closed” to find items that have been marked as closed. When 
the filter selections are made, click the “Filter” button and the respective Submittals or Submittal 
Packages will appear in the grid, as shown below. 
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25.04 Creating Submittals in the Submittal Register (GC or CMR) 
 

 To create new submittals in the Submittal Register, click “Submittal Register” and then the “Add Item” 
button. 

 

 
 

 Then complete the required fields. Enter a Title and select the Specification Section and Category. 
Complete the other fields required by project procedures. Then click either “Save” to complete entering 
new submittals or “Save & Add New” to save and start another submittal. 

 

 
 

 Once a submittal has been saved, the tools for uploading attachments become available. Documents can 
be uploaded by either using the “drag-and-drop” feature or by clicking the “Attach” button. 
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 If the “Attach” button is clicked, a pop-up will appear. Click the “Upload from your Computer” button to 
locate a locally stored document. 

 

 
 
 

 When uploading, a dialogue box will appear for the user to select the applicable Submittals folder in the 
eBuilder Documents module. After clicking on the applicable Submittals folder, click the “Select” button 
to initiate the upload.  
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 When the upload is completed, click “Done”. 
 

 
 

 The file is then attached to the submittal and can be viewed in a pop-up window by clicking on its 
filename. 
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 Saving the submittals causes them to appear in brown italic as drafts in the Submittal Register. (Note 
that this list shows drafts because it is set to include Drafts in the Filter.) 

 

 
 

 The buttons in the “Item Details” column of the Submittal Register allow users to interact with certain 
details of the submittals without reopening the records. 

 

 
 

 For example, the paperclip button allows users to bring up a dialogue box allowing users to view or add 
attachments to the submittal. 
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 A submittal may be re-opened by clicking on its Title. 
 

 
 

25.05 Creating Submittal Packages (GC or CMR). 
 

 Submittal packages can be created by clicking on Submittal Packages and then clicking the “Create 
Package” button. 

 

 
 

 Select the specification section of the package in the “Submittal Package Number” field, enter its 
“Submittal Package Name” and any other relevant information and click the Save button. 
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25.06 Adding Submittals to Submittal Packages (GC or CMR). 
 

 Once a submittal package is saved, submittals can be added to it by clicking the “Add Items” button. 
 

 
 

 The user will be able to create new submittals, but keeping the setting to “Add Existing Items” & clicking 
“Add” will allow submittals that are in the Submittal Register to be added to the submittal package. 

 

 
 

 In the pop-up box that appears, mark the check boxes next to the submittals to be linked to the 
submittal package and click the “Add to Package” button. (Note that the top of the pop-up box has filters 
that allow the user to find submittals more easily in the Submittal Register, if there are many.) 
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 After clicking “Add to Package”, the user will be asked to confirm the addition, and then the submittals 
will be added to the submittal package. 

 

 
 

 Note that the submittals brought into the submittal package now appear in the Submittal Register as 
“Open”, rather than “Draft”, and show what submittal package they are in. 
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25.07 Sending the submittal package to the CA (GC or CMR). 
 

 Click on “Submittal Packages” to see the list of submittal packages, then click the check box next the 
submittal package to be sent to the CA, and then click “Send for Review.” 

 

 
 

 A pop-up box will open after clicking “Send for Review”. The Submittal Coordinator(s) will be pre-
populated, but the user will be required to enter a “Review Complete Due Date” and will have the option 
to cc others, either by user role or by name. In addition, the user can add a message regarding the 
submittal package in the “Message” box. Upon completion, click the “Send for Review” button.   
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25.08 Sending a submittal package for A/E review (CA). 
 

 When the GC or CMR has sent a submittal package to the CA (as Submittal Coordinator), the CA will be 
able to see, in the Submittal Register, the “Held By” field populated with whoever holds the submittals at 
the moment and will also see the Status field values for each submittal as toggleable. It is the CA, as 
Submittal Coordinator, who marks the Status of submittals in the system, based on the A/E’s 
communication after their review. (See below.) 

 

 
 

 To send submittals to the A/E, the CA will locate the applicable submittal package from the Submittal 
Packages list and open the submittal package. In the submittal package, the CA marks the check box next 
to the submittals and clicks “Forward for Review.” 

 

 
 

 A pop-up box will appear that requires a “Respond By” date to the selected or entered. The “Forward 
To” box is where the CA enters the A/E users to whom the submittals will be sent for review.  
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 To select users, locate and click on their name(s) and click the right arrow button. There are optional 
boxes to cc others, either by user role or by name and a message box to add a text message. (Note that 
there is also a “Notify Only” optional choice, as opposed to the “Action Required” option.) To complete 
the send action, click the “Forward for Review” button.  

 

 
 

 The links in the Reviewers column show who the reviewers are. 
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 The “Held By” column, shown here in Submittal Packages, identifies who has the item, ball-in-court. 
 

 
 

25.09 Submittal Review by A/E Users (A/E) 
 

 When the CA has sent a submittal package to the A/E, the A/E will be able to see, in Submittal Packages, 
the “Held By” field populated with whoever holds the submittals at the moment. The A/E user clicks on 
the Package # to go into the package. 

 

 
 

 In the Submittal Package, individual submittals can be opened by clicking on the Title or # of the 
submittal. 
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 In the submittal records, under the “Documents” tab, (A) click on the file name to open a viewer to see 
the file and (B) click the “Download” link below the file name to download  the file. Additional files can 
be attached by (C) clicking the “Attach” button and (D) click the Comments tab to add or request a 
comment. In addition to noting the A/E marking/stamp when sending the package back to the CA, the 
A/E should also note the marking in the comments of each submittal. 

 

 

 
 
 

 After clicking “Request Comment”, a pop-up will appear that allows the A/E to select their subconsultant 
users in the “To” field by selecting their names and pressing the “>” to move them to the right panel. The 
“Message” field allows the A/E user to provide instructions to the subconsultants. Upon completion, click  
the “Request Comment” button to send the notification to the subconsultant. 
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 When the subconsultant responds, their comments will be in the Comments tab of the submittal 
instance. 

 

 To complete the review and return the submittals to the CA, the A/E goes into the Submittal Package, (A) 
selects the applicable submittals and then (B) clicks “Review Complete”. 

 

 
 

 A pop-up screen will appear to allow confirmation. 
 

 Very important: (A) The A/E needs to note, for each of the submittals being sent back to the CA, what 
their marking is. The CA controls the toggle on the Status column for submittals, so this message is 
important to inform the CA what the A/E stamp says. Then, (B) click “Review Complete”. 
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25.10 Return of submittals to GC/CMR (CA) 
 

 When the A/E has returned a submittal package, the CA will click on the “Comments” tab to review the 
comments left by the A/E. Click the “+” sign to the left of the submittal name, as shown below, to open 
the comments. The comments will also appear in the submittal items, themselves. 

 

 
 
 

 While in the submittal package, click on the “Items” tab, then click the arrow in the Status field in the 
row of a submittal, and then select the marking indicated by the A/E. 

 

 
 
 

 This will prompt the CA to enter a comment about the action. 
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 In the submittal package, after (A) updating the statuses of the submittal items, the CA then (B) selects 
all of the submittal items and (C) clicks “Send to Contractor.” 

 

 
 

 A pop-up will appear. The CA can provide a comment in the message box if applicable, then click  
“Send to Contractor.” 
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25.11 Closing Returned Submittals (GC or CMR) 
 

 The GC or CMR will receive notification that the submittal package has been returned and can find the 
submittal package in the Submittal Packages list. Noting that (A) the submittal package is now held by 
them, as users, (B) the GC or CMR click on the submittal package title or package number. 

 

 
 

 After opening the package, click on a submittal’s title or # to open the submittal, or open the submittal 
from the Submittal Register. 
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 If the submittal is approved, it can be marked by the GC or CMR as closed by clicking the “Close” button. 
(Note that the “Close” button then changes to a “Re-Open” button, allowing for the submittal to be re-
opened.) 

 

 
 

 Refer to Section 25.03 for instructions on how to use filtering to list submittals that are Draft, Open and 
Closed. 

 

25.12 Revision Submittals 
 

 If a submittal package contains one or more submittals that have a “RAR” (Revise and Resubmit) Status, 
check the box(es) to the left of the submittal(s) and then click the “Create Revision” button. 
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 That brings up a screen for the creation of a revised submittal package. The revised package (A) has the 
same package number as the package being revised, except that the revision number is incremented up 
by 1; (B) contains a newly created revised submittal (or multiple revised submittals, if multiple submittals 
require revision); and (C) the revised submittal, itself, is identified by an increased revision number, 
incremented up by 1. If is all correct, (D) click Save. 

  

 
 

 The default views in the Submittal Packages list and the Submittal Register will now only show the 
revised version of each. The original version can still be seen, using the filter controls. For example, (A) in 
the Submittal Packages list, (B) select the filter options for Open, Closed and Draft to (C) make both the 
revised and original submittal package visible. The (D) Status of each option will be displayed.  
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 The GC or CMR can access the revised submittal package and upload attachments and comments to the 
revised submittal, which is now linked to the submittal package. Upon completion, the GC or CMR would 
follow the steps outlined in Section 25.07 to send the submittal package to the CA. 
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Section 26: 7989 AA Project Closeout 
  

26.01 Accessing the Process 
 

 Log in to e-Builder: https://gov.e-builder.net/auth/www/index.aspx?ReturnUrl=%2f. On your homepage, 
Go to the “Processes” tab and select the AA Project you want to closeout from the  “All Projects” 
dropdown list. 

 

 
 

26.02 Form 7989 – AA Project Closeout (Process Initiator) 
 

 Click the “Start Process” button. 
 

 
 

 Click on the link entitled “7989 AA Project Closeout (7989)”. 
 

 
 

 Read the “General Instructions” and fill in the applicable fields under “Project Information”. 
 

 

https://gov.e-builder.net/auth/www/index.aspx?ReturnUrl=%2f
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 Complete the section entitled “Consultant/Contractor/Supplier Information” under “Add New Item for 
Consultant/Contractor/Supplier Information”. The first vendor input should be the project On-Call 
Consultant. To add a vendor, click on the “Lookup” link in the Vendor field to find the project On-Call 
Consultant. Then, provide the “On-Call Contract No.” and “Task Number” and click the “Add” button.   

 

 Next, click on the “Lookup” link in the “Vendor” field to select any other Contractors that provided 
services on the subject project, the Contract Number and PO Number for the subject Contractor. If the 
Contractor is not listed in “Lookup”, provide the name of the Contractor in the “Other Vendor” field and 
click the “Add” button upon completion. Repeat this process for each Contractor having performed 
Work on the project. 

 

 
 

 Complete the section entitled “Project Closeout Supporting Documentation”. Drag and drop executed 
copies of the requested forms into their respective fields. 
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 If the form submission is not applicable to this project (the project scope of work does not include the 
construction, repair, alteration or addition to any state building or any other public works of the state), 
then check the appropriate “Closeout Documents – Not Applicable” field. 

 

 ∗ Note that there is a field to upload “Form 7810 – Certificate of Substantial Completion”, as well as a 
field entitled “Substantial Completion”. If you have a paper copy of the substantial completion form, it 
should be uploaded to the respective field.  

If the substantial completion form was completed in eBuilder, click on the “Lookup” link in the 
“Substantial Completion” field to open the “Filter Processes” page for the subject project. 

 

 
 

 Make sure both the “Open” and “Finished” boxes are checked and click the “Filter” button. The process 
link to the subject project’s substantial completion form will appear in the process table. Click on the link 
in the “Process” column for the subject substantial completion form to be added to the closeout 
supporting documents. 

 

 
 

 
  

 Upon completion, scroll down to the bottom of the page and click the “Take Action” button to submit 
your project closeout documentation. If the project closeout submission is considered incomplete, the 
submission will be returned to the Process Initiator to provide additional information. Instructions for 
the additional information required will be noted under the “Comments” tab. If the project closeout 
submission is complete, no further action is necessary. 
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Section 27: 7990 Project Closeout 

 
 

27.01 Coming Soon 
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